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G. H. Gillespie Associates, Inc. Software License Agreement
(PBO Lab for the Single-User)

CAREFULLY READ ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT BEFORE OPENING THIS PACKAGE. IF
THESE TERMS AND CONDITIONS ARE NOT ACCEPTABLE TO YOU, PROMPTLY RETURN THIS PACKAGE AND ALL OTHER
COMPONENTS OF THIS SOFTWARE PRODUCT TO THE PLACE OF PURCHASE FOR A REFUND. OPENING THIS PACKAGE
INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

LICENSE. G. H. Gillespie Associates, Inc. grants you a license to use the PBO Lab computer program (“Program”) recorded on the
enclosed diskettes and/or CD-ROM (“media”) on one single-user computer. You may physically transfer the Program from one single-
user computer to another single-user computer as long as you use the Program on only one single-user computer at a time. You may not
(a) use the Program on a multiple-user computer or a network of single-user or multiple-user computers without the expressed written
persmission of G.H. Gillespie Associates, Inc., (b) electronically transmit the Program over a network of single-user or multiple-user
computers, (c) rent or lease the Program to others, or (d) reverse engineer, decompile or disassemble the Program.

OWNERSHIP. Your license is not a sale of the Program. G. H. Gillespie Associates, Inc. retains title to the PBO Lab computer program.
You only acquire title to the enclosed media.

COPYRIGHT. The Program is protected by United States copyright laws and international copyright treaties. You may (a) copy the
Program onto other media solely for archival or backup purposes or (b) copy the Program onto a single hard disk and retain the copy of
the Program on the enclosed media solely for archival or backup purposes. You must retain all copyright notices for the Program on all
copies of the Program. You may not make any other copies of the Program except as provided herein.

ASSIGNMENT. You may assign your license to another person if that person agrees to the terms and conditions of this Agreement. You
must physically transfer the Program to that person and destroy any and all copies of the Program which you do not physically transfer to
that person.

DURATION. Your license is effective for an indefinite term unless you fail to comply with a term or condition of this Agreement. If you
fail to comply with a term or condition of this Agreement, your license automatically terminates and you must destroy your copies of the
Program.

LIMITED WARRANTY. G. H. Gillespie Associates, Inc. warrants that the enclosed media are free of defects in materials and workman-
ship. If you discover a defect and return the enclosed media to the place of purchase within ninety (90) days after the date of your
purchase, the enclosed media will be replaced without any additional charge. THIS LIMITED WARRANTY REPLACES ALL OTHER
WARRANTIES EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS OR A PARTICU-
LAR PURPOSE. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES SO THESE EXCLUSIONS
MAY NOT APPLY TO YOU. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY ALSO HAVE
OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY. G. H. GILLESPIE ASSOCIATES, INC. SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUD-
ING INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING FROM USE OF THE PROGRAM. SOME STATES DO NOT
ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS
LIMITATION MAY NOT APPLY TO YOU.

GENERAL. This Agreement contains the entire understanding of the parties and supersedes all prior communications, proposals, agree-
ments, and contracts and purchase orders pertaining to the Program.

G. H. Gillespie Associates, Inc.
P. O. Box 2961, Del Mar, California 92014 U.S.A.
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I agree to the terms and conditions of the G. H. Gillespie Associates, Inc. Software License Agreement
as stated on the preceding page.

_______________________________ ______________________
Signature Date

_______________________________ ______________________
Printed Name Organization

__________________________________________________________
Street Address

_______________________________ ______________________ _______________
City State or Province Postal Code

_______________________________
Country
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PBO Lab Overview
The Particle Beam Optics Laboratory (PBO Lab) is a
unique user interface shell that provides an environment
for the graphical set up of beamline models and the
execution of multiple computational programs used for
the design and analysis of particle optics systems and
accelerators. Computational codes are integrated together
as Application Modules in the PBO Lab environment. A
single beamline model in PBO Lab can be used for design
and analysis tasks with any of the installed Application
Modules. PBO Lab generates the appropriate native inputs
without requiring any knowledge of the various formats
and specific syntax needed by the different programs.

None of the Application Modules are required in order to
use PBO Lab. PBO Lab provides a built-in first-order
optics module to graphically illustrate the qualitative
optical features of a beamline. In addition, an extensive
interactive tutorial system has been integrated with PBO
Lab to assist users with the technology of accelerators
and various beam physics phenomena.

This Chapter provides a brief summary of the different
PBO Lab Application Modules. The remainder of this
manual describes the application-independent features of
the PBO Lab environment. Each of the computational
codes supported by PBO Lab is described separately in
the Application Module Supplements to the PBO Lab User
Manual.

PBO Lab is implemented with the second generation
Multi-Platform Shell for Particle Accelerator Related
Codes (S.P.A.R.C.-MP) application framework. A variety
of computer platforms are supported by PBO Lab.
Although there are some minor differences, the user
interface is consistent for all platforms. All of the figures
in this manual have been produced from PBO Lab running
under Windows™ on a desktop personal computer.

The Particle Beam Optics
Laboratory provides an intuitive and
easy-to-use graphic user interface
that integrates a variety of optics
programs as Application Modules in
a single software package.

Refer to the PBO Lab Application
Modules Section in the Getting
Started Chapter.

Refer to the Chapter on PBO Lab
Analysis Tools - Focusing and Bending
Modules.

PBO Laboratory has been developed
specifically to support several
different particle optics design and
analysis codes, including:

TRANSPORT,
TURTLE,
MARYLIE and
TRACE 3-D.

The consistent treatment of varied
features in the different optics
programs enhances the productive
use of these codes in the PBO␣ Lab
environment.

3
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TRANSPORT Summary
TRANSPORT is a FORTRAN matrix multiplication
program developed for modeling charged particle optics.
The program is particularly useful for the design and
simulation of static-magnetic beam transport systems,
although it can be applied to other problems in accelerator
design as well. The version included with PBO Lab has
the ability to model beamlines to first-, second- and third-
order. TRANSPORT has a variety of fitting and problem
constraint capabilities, and can be used to examine the
effects of field errors, component misalignments and
similar non-ideal beamline conditions.

TURTLE Summary
The TURTLE (Trace Unlimited Rays Through Lumped
Elements) program is useful to support the analysis of
beamlines designed with TRANSPORT. TURTLE is a
FORTRAN program that allows the evaluation of the
effect of aberrations that exist in beams with small phase
space volume. These include higher order chromatic
aberrations, effects of non-linearities in magnetic fields,
and higher order geometric aberrations due to the
accumulation of second-order effects.

MARYLIE Summary
MARYLIE is a FORTRAN program for beam transport
and tracking, based on a Lie algebraic formulation of
charged particle trajectory calculations. MARYLIE is
useful for the design and evaluation of both linear transport
systems and circulating storage rings. The program is able
to compute transfer maps and trace rays through single or
multiple beamline elements for the full six-dimensional
phase space without the use of numerical integration of
traditional matrix methods. The effects of high-order
aberrations are computed as an integral part of the Lie
algebra approach. All non-linearities, including chromatic
effects, through third order are included.

The TRANSPORT optics program is a
matrix multiplication code that includes
the ability to model optics up to and
including third order.

The TURTLE program supports the
analysis of beamlines designed for
TRANSPORT and includes multi-
particle ray tracing.

The MARYLIE program is based on
Lie algebraic methods and is useful
for both linear transport systems and
circulating storage rings. It can be
used to compute transfer maps, trace
particle rays and carry out tracking
simulations.

4
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TRACE 3-D Summary
TRACE 3-D is a FORTRAN beam dynamics program
that calculates the envelopes and phase-space ellipses of
a bunched beam, including linear space-charge forces,
through a beamline. TRACE 3-D also supports fourteen
different types of fitting or beam-matching options.
Matching options will vary Initial Beam parameters for a
matched beam in X,Y planes, Z plane, X,Y,Z planes
(Upright), or in X,Y,Z planes. Fitting options will vary
element parameters to fit a desired beam in X, in Y, or in
the Z plane, in X,Y planes, or in X,Y,Z planes. The Initial
Beam can also be fit for a desired beam in X,Y,Z planes.
In addition, TRACE 3-D can vary element parameters
for fitting desired R-Matrix or Sigma-Matrix elements,
fitting for a round beam, or fitting for specified phase
advances in selected phase planes.

Application Module Professional Versions
FORTRAN source code for several of the PBO Lab
Applications Modules are available in Professional
Versions.  The Professional Version of an Application
Module allows the user to modify the FORTRAN physics
code in order to customize PBO Lab for their specific or
unique requirements.  Contact AccelSoft for further
information.

Future Application Modules
Additional Applications Modules for PBO Lab are
planned for the future, and several are currently under
development.  Information on new Application Modules
for each computer platform supported by PBO Lab will
be posted on the AccelSoft web site (www.ghga.com/
accelsoft) as they become available.

The TRACE 3-D program calculates
the envelopes and phase-space
ellipses of a bunched beam, including
linear space-charge forces, through
a beamline.

5
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This Chapter is intended to provide users with a brief
introduction to PBO Lab that will get them up and running
quickly. It covers the installation and registration of the
PBO Lab application and provides an overview of the use
of the software.

Installing PBO Lab
The PBO Lab software is distributed on CD-ROM and
includes the PBO Lab application, the required libraries,
Tutorials and some example files. Installation requires
approximately 15 MB of free disk space.

Installation on the PC
To install the PBO Lab application on a PC running
Windows or Windows NT, insert the Windows PBO Lab
CD and double-click the Setup icon as shown in Figure 1.
Setup will guide you through the installation process.
Simply follow the instructions of the Setup Wizard.

Figure 1.  Double-click the “Setup” Application.

Installation on the Macintosh
To install the PBO Lab application on a Macintosh
PowerPC running Mac OS version 7 and up, insert the
Mac PBO Lab CD and simply drag the PBO-Lab folder
to your hard drive.

For work stations refer to the platform-specific Installation
Supplement distributed with the PBO Lab software for
these platforms.

Run Setup on the PBO Lab CD to
install the PBO Lab application on
your PC.

PBO-Lab

Drag the PBO- Lab folder to your hard
drive to install the PBO Lab
application on your Mac.

PBO Lab 2.0 User Manual
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Uninstalling PBO Lab
To uninstall the PBO Lab application under Windows or
Windows NT, run the “Add/Remove Applications” tool
in your Control Panel folder. Select the PBO Lab
application from the tool’s list of programs and press the
uninstall button. This will remove the PBO Lab application
and all of the libraries that were installed with PBO Lab.

To uninstall the PBO Lab application on a Macintosh,
simply drag the PBO-Lab folder to the trash.

For work stations refer to the platform-specific Installation
Supplement distributed with the PBO Lab software for
these platforms.

PBO Lab Registration

Registering PBO Lab for the first time
The Particle Beam Optics Laboratory and individual
Application Modules are distributed on a single CD ROM.
After installing the software on your hard drive, it must
be registered with either a 30-Day Evaluation License
Number or with your Personal License Number assigned
when you purchased the software.  A CD Key is also
required that tells PBO Lab which Application Modules
will be activated.  Both the License Number and CD Key
are on the Packing Slip shipped with PBO Lab and on the
CD case itself. A 30-Day Evaluation License Number
allows for a 30 day evaluation period of the PBO Lab
software.  When the software is purchased, a Personal
License Number will be provided.

Upgrading to a newer version of PBO Lab
If you have already registered with a Personal License
Number and CD Key and have received an updated version
of the PBO Lab software, you do not need to reregister.
Simply replace the older version of PBO Lab on your
hard drive with the updated version.  Refer to the Uninstall
and Installation Sections in this Chapter.

On the PC, you can uninstall PBO Lab
using “Add/Remove Programs” in
your Control Panels Folder.

On the Mac, you can uninstall PBO
Lab by simply dragging the PBO-Lab
Folder to the trash.

After installing PBO Lab it must be
registered with either a Demo License
Number or with your Personal License
Number assigned when you
purchased the software.

If you have previously installed PBO
Lab with a Personal License Number,
then you do not need to reregister
after upgrading to a newer version.
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Activating additional Application Modules
If you are already registered with a Personal License
Number and CD Key, and have now purchased additional
Application Module(s), you will need to reregister the
software in order to activate the new Module(s).  A new
CD Key will be assigned to your Personal License Number
when you purchase additional Application Modules. Start
PBO Lab and open the Registration window from the
Tutorial menu.  After entering your new CD Key you will
need to quit and restart the PBO Lab application.  This
will insure that the new Application Modules are activated
properly.

If you received a new PBO Lab CD (updated version)
when you purchased additional Application Modules, you
will need to install the new version and reregister the
software as described previously.

Upgrading from the PBO Lab 30-Day Evaluation
If you are upgrading from the 30-Day Evaluation License,
you must reregister with your new Personal License
Number and CD Key included with your purchase of the
PBO Lab software.  Start PBO Lab and  open the
Registration window with the Register button in the Demo
Dialog window.  After entering your new Personal License
Number and CD Key in the Registration window, you will
need to quit and restart the PBO Lab application.  This
will insure that any Application Modules included in your
purchase are activated properly.

You will need to reregister with your
new CD Key if you have purchased
additional PBO Lab Application
Modules.

If you have registered with a 30-Day
Evaluation License Number, you will
need to reregister with  your new
Personal License Number and CD Key
when you purchase PBO Lab.
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Running PBO Lab
The PBO Lab application is started by double-clicking
the PBO Lab application icon. A new untitled Document
Window will be opened. Use the Open command in the
File Menu to open a specific model file. Figure 2 illustrates
the principal parts of the PBO Lab Document Window:
the Palette Bar, Menu Bar, Button Bar, Global Parameters,
the Work Space and beamline Model Space. Document
Windows may be expanded horizontally and vertically.
An unlimited number of Document Windows may be
opened at any one time.

On the Macintosh, the Menu Bar is at the top of the
monitor. This maintains the native look and feel for the
Mac OS. On other platforms, the Menu Bar appears in
application windows as illustrated in Figure 2 below.
Otherwise the user interface is consistent for all platforms
supported by PBO Lab.

Model Space

Work Space

Beamline Model

Palette Bar of 
Beamline Elements

Application 
Context

Document Window 
Menu Bar

Document Window 
Button Bar

Beamline Global 
Parameters

Figure 2.  PBO Lab Document Window.

Double-clicking the PBO Lab
application icon will open an untitled
PBO Lab Document Window.

PBO Lab model file icon.
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PBO Lab Application Modules
A variety of particle beam analysis and design programs
are implemented as Application Modules in the PBO Lab
user interface. A specific Application Context is selected
with a pop-up menu in the Document Window Button
Bar as illustrated in Figure 2. The Application Context is
used to provide the user with various application-specific
feedback such as the native inputs for an application. The
applications listed in the Application Context pop-up
depend on which Application Modules are installed in
your version of PBO Lab.

Other parts of the PBO Lab user interface will also have
different content based on the installed applications. For
example, some menus have application-specific sub-
menus for each installed Application. There are also some
user interface windows that are either completely
application-specific or, in some cases, include application-
specific tab panels for the different Application Modules.
The Special Parameter Settings window is an example of
a PBO Lab window with application-specific tab panels.
Application-specific aspects of the user interface are
described separately in individual Application Module
Supplements to the PBO Lab User Manual.

The Application Context pop-up in the Document Window
does not have to be set to a particular application in order
to execute commands for that Application Module.
However, the Application Context selection is used to
indicate which input parameters are native inputs for the
current context. Native inputs are indicated in the Global
Parameters and in each Piece Window using green dots
that appear to the right of a parameter. The Application
Context is also used in the Marker and Final Pieces for
setting a location-specific Constraint or Diagnostic.
Creating a new Constraint or Diagnostic with these pieces
will always open the appropriate application-specific
window for the current Application Context.

The Application Context is used to
display and access application-
specific inputs for each of the
installed Application Modules.

PBO Lab menus contain application-
specific sub- menus for each of the
installed applications. The Menu
commands do not depend on the
current Application Context.

Application-specific windows provide
access to native inputs that are not
shared between installed
applications. The selected Application
Context is used to activate
application-specific buttons and, in
some cases, determine which
application-specific windows will be
opened.
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Building a Beam Line Model and
Editing Input Parameters

PBO Lab utilizes several sets of user input parameters to
describe an accelerator beamline model for the different
computational programs integrated with the interface. The
user inputs that provide data for running the Application
Modules are grouped by the following:

- Global Parameters
- Piece Parameters
- Command Control Parameters
- Options and Output Parameters

All parameters in PBO Lab have defaults built in. Once a
beamline has been constructed graphically, with or without
any parameter editing, a beamline model is completely
defined for executing any of the installed Application
Modules.

The Beamline Global Parameters are set in a scrollable
panel at the top of each Document Window. The Global
Parameter panel contains input parameters such as the
Particle Charge, Particle Mass and Beam Energy that are
global to the entire beamline. Various units options are
available for several of the Global Parameters. For
example, Figure 3 illustrates the use of a units pop-up for
inputting the Beam Energy in terms of the equivalent
momentum units (in p(GeV/c)).

Figure 3.  Global Parameter Panel of the Document
Window Illustrating a Pop-up Units Menu.

Refer to the Beamline Global
Parameters Section in the User
Interface Chapter for a description of
the PBO Lab Global Parameters.
Refer to the Global Parameters
Section in each Application Module
Supplement for a description of
application-specific Beamline Global
Parameters.

The first step in building a PBO Lab
beamline model is to review the
Global Parameters.

The Beam Energy in PBO Lab can be
specified in any one of several ways.
Options include specifying the
relativistic β or γ of the particle, the
particle momentum, as well as the
traditional beam energy units of eV,
keV, MeV or GeV. The PBO Lab
interface automatically converts
between units when the pop-up
selection is changed.
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A beamline is constructed by
dragging Piece icons from the Palette
Bar to the Model Space. Pieces may
also be placed on the Work Space.

The Global Parameters panel may be
closed to provide more area for the
Work Space.

A colored tab is used to select and
drag Selections on the Work Space.
The tab is red when a selection has
been made.

Valid Insertion Point

A bold connection line indicates that
a valid insertion point has been
located while dragging a selection
from the Palette Bar or the Work
Space.

The second step is to “build” a beamline to be modeled.
An accelerator beamline model is built by selecting and
dragging the beamline pieces from the Palette Bar to the
Model Space of the Document Window. Figure 4
illustrates an example of a Document Window with a short
quadrupole lattice model built on the Model Space. Other
beamline segments, sublines and pieces shown in Figure
4 are saved on the Work Space.

Figure 4.  Beamlines on the Model Space and Work
Space of a Document Window.

The scrolling Palette Bar provides access to all of the
beamline pieces available in PBO Lab. Selecting, dragging
and dropping a piece on the Model Space will result in
that piece being attached to the end of the beamline model
nearest the drop point. Pieces from the Palette Bar or Work
Space may be inserted between pieces in the beamline
model by making a selection and dragging it to a
connection point. Connection points are identified by the
black lines between each piece in the beamline. A bold
connection line indicates that a valid insertion point has
been located while dragging a selection from the Palette
Bar or from the Work Space. Releasing the mouse button
(dropping the selection) while the connection line is bold
will insert the selection at that location in the beamline
model.
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The Piece Parameters define all inputs for each piece in the
beamline model. Double-clicking on an individual piece,
such as one of the “Quad” pieces in the example shown in
Figure 4, opens a Piece Window like that illustrated in
Figure 5. The beamline element parameters are edited in
Piece Windows. Application-specific Special Parameter
Settings are also accessed in the Piece Windows: for
example, the user can select a parameter as a match variable
or import variable or define an algebraic expression for the
parameter. The “S” button to the left of each parameter is
used to open a Special Parameter Settings Window as
illustrated in Figure 5. The Special Settings Windows have
tab panels that provide access to application-specific
options. These are described in the individual Application
Module Supplements to the PBO Lab User Manual.

Guidance Limits Alert Users 
if Parameters Are Outside 

Certain Bounds

Tutorial Button Accesses
Physics and Technology

Information Database

Units Options Are Available 
for Most Parameters 

Native Parameters are 
Indicated for the Current 

Application Context

Parameter "S" buttons open 
Special Parameter Settings 
Windows for Application 

Specific Parameter Options

Figure 5.  PBO Lab Piece Window and Special Parameter Settings Window.

All parameters in PBO Lab have
defaults built in. Once a beamline has
been constructed graphically, with or
without any parameter editing, a
beamline model is completely
defined.
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Dependent Parameters, based on 
the Selected Parameter Set, are 
Automatically Calculated from

Editable Active Parameters 

Green Dots Indicate Native 
Inputs for the Current 
Application Context

Many Pieces Provide
Different Parameter Sets

to Define an Element

Additional Element 
Parameters are Accessed 

by Clicking Piece 
Window Tab Panels

Figure 6.  Parameter Sets and Tab Panels for the Quadrupole Piece Window.

Some Piece Windows have their input parameters
grouped in tab panels, such as those of the Quadrupole
Piece shown in Figure 6, which includes tab panels for
Fringe Field, Geometry and Location Parameters. Many
pieces provide a variety of parameter sets that may be
used to define the element. For example, a quadrupole
may be minimally defined by length and quad coefficient
value; or by length, aperture and pole tip magnetic field;
or by length and magnetic field gradient.
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Many pieces provide multiple
parameter sets that may be used to
define the element.

A green dot next to a parameter
indicates a native input for the
current Application Context.

Different units options are provided
for most Piece Parameters. The units
selections are independent of the
specific units required by the different
applications.

Guidance limits are provided for each
Piece Parameter. However, any value
for a parameter may be used. The
guidance limits are “soft” and are
only used to alert the user if the set
of input parameters may have
impractical consequences.

Automatic calculations are made between the different
parameters sets, allowing the user to select the parameters
to specify an element independent of the native inputs
used by specific applications. In Figure 6, the Quadrupole
Strength selection switches between the different
parameter sets available for the Quadrupole Piece.
Dependent parameters are automatically calculated by
PBO Lab and are not editable. Which parameters are
dependent is based on the parameter set selection.

The user interface indicates which parameters are used as
native inputs for the current Application Context. Green
dots to the right of parameters in the Piece Windows
indicate the native inputs for the current selection in the
Application Context pop-up of the Document Window.

A variety of different units options may be selected for
each parameter independent of the native units required
by the different computational codes. Several unit pop-
ups include “smart units”, which scale dynamically with
certain Global Parameters. For example, all parameters
that have the dimensions of length include “β-Lambda”
as a units option. The value of the β, the relativistic velocity
parameter of the particle, is determined by the Global
Parameter values for the Particle Energy and Mass, while
the value of λ is set by the Radio Frequency Global
Parameter.

Expert system-type rules provide guidance for editing
input parameters and additional displays, such as effective
focal lengths and phase space plots, which provide useful
feedback to the user. The guidance limits are “soft” and
are not used to restrict the input; any parameter value may
be entered. The limits are intended to provide the user
with estimates of a practical range for each parameter.

All parameters in PBO Lab have defaults built in. Once
a beamline has been constructed graphically, with or
without any parameter editing, a beamline model is
completely defined.
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The Getting Started Chapter of the User Manual is only
intended to provide the user with a brief overview of the
PBO Lab environment. The remainder of the User Manual
provides more information on the material presented here,
as well as other important subjects on the use of the PBO
Lab. All users are encouraged to read the entire User
Manual. Application-specific aspects of the user interface
are described separately in individual Application Module
Supplements to the PBO Lab User Manual.
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This Chapter provides a description of the PBO Lab user
interface and defines the terms that are used to refer to
different parts of the interface. Familiarity with the
preceding Getting Started Chapter is assumed.

The Document Window
The PBO Lab Document Window is the main user
interface for building a beamline model and performing
analysis tasks with that model. Figure 7 diagrams the
primary parts of the PBO Lab Document Window that
are described in this Chapter.

An unlimited number of Document Windows may be open
at any one time, with different beamline models in each
window. Beamline elements or groups of elements may
be exchanged between Document Windows using the
Copy and Paste commands.

Document Windows are the primary
PBO Lab interface for a beamline
model.

An unlimited number of Document
Windows may be open at any one
time.

Beamline Global ParametersApplication Context Menu Bar Button Bar

Scrolling Palette Bar

Work Space

Beam Line Model

Number of Pieces in  Beamline ModelModel SpaceModel Space Scroll Bar

Drift PieceSublinesInitial Beam 
Parameters

Figure 7.  Primary Parts of the PBO Lab Document Window.

PBO Lab 2.0 User Manual
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The Document Window is divided into two main areas,
the Model Space and the Work Space. A beamline model
is constructed by dragging elements from the Palette Bar
to the Model Space. The Work Space provides an area to
store elements and beamline segments that are not treated
as components in the beamline model. Input parameters
for individual elements in the beamline are accessed by
double-clicking the Piece icons in the Model Space.
Beamline Global Parameters, which apply to the entire
beamline model, are displayed over the Work Space and
can be toggled on and off from the View menu or the
Button Bar. The Palette Bar on the left edge of the
Document Window can also be hidden in order to
maximize the Work Space and Model Space areas in the
Document Window, as illustrated in Figure 8 below.

A beamline to be modeled is built on
the Model Space of a Document
Window.

Pieces are selected from the Palette
Bar and dropped onto the Model
Space.

The commands to Hide or Show the
Palette Bar and to Hide or Show the
Global Parameters can be used to
increase the size of the Model Space
and Work Space in the Document
Window.

Model Space

Work Space

Show/Hide Palette Bar

Show/Hide Global Parameters

Figure 8.  Document Work Space and Model Space.

A variety of computer platforms are supported by PBO Lab.
Although there are some minor differences, the user
interface as described here is consistent for all platforms.

The following Sections describe the primary components
of the PBO Lab Document Window, including the Model
Space and Work Space, the Menu Bar, Button Bar, Palette
Bar, and Global Parameters. The user interface for element
input parameters and beamline construction features are
also described here.
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The Menu Bar
The PBO Lab interface has six pull-down menus in the
Menu Bar. Figure 9 below illustrates the first three pull-
down menus: File, Edit and View. These are discussed
below. The Commands, Tools, and Tutorial menus are
described separately. The content for some of the menus
is dependent on which of the available Application and
Tool Modules are currently installed in PBO Lab.

Figure 9.  PBO Lab File, Edit and View Menus.

File Menu
The first menu is the File Menu. The New command opens
a new untitled PBO Lab Document Window. The Open
command is used to open a previously saved model. Both
the New and Open commands will create and activate a
new PBO Lab Document Window.  The Close command
is used to close the active Document Window. The Save
and Save As commands are for saving the current model
in the active Document Window. The Print Setup
command opens the standard printer setup dialog. The
Import and Export commands have sub-menus for
installed Application Modules. Applications that support
the Import command will allow PBO Lab to construct a
beamline model from native Input files. The Export
command can be used to write native Input files. The last
command in the File Menu is Exit, which closes all
windows and quits PBO Lab. PBO Lab will prompt you
to save open Documents before quitting. The File
commands follow the standards for each of the platforms
supported by PBO Lab for tasks such as opening dialogs
to load model files, etc. Users unfamiliar with the standard
file dialogs should consult their operating system
documentation for additional information.

On the Mac OS, the Menu Bar is not
in the Document Window. It is at the
top of the screen, which is the
standard for that platform.

The Application Module sub-menus
only appear for installed Modules, so
your menus may look different from
those shown in Figure 9.

There are buttons in the Document
Window Button Bar for the standard
File menu commands.

Create a New 
PBO Lab Document

Open an Existing 
Document File

Close the Current 
Document Window

Save the Current 
PBO Lab Document

Export and Import Menu commands
allow the user to read and write
native input.
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Edit Menu
The second menu in the Document Window is the Edit
Menu, which has eight commands organized into four
groups. The first group contains standard Cut/Copy/Paste
and Delete commands for beamline components. The next
three groups contain commands that are used to
manipulate the beamline model and are described in the
Beamline Construction Section of this Chapter.

The Cut command deletes (cuts) any selected pieces from
the beamline model and copies them to the clipboard for
future pasting to the current Document or to another
Document Window. The Copy command is used to copy
selected pieces to the clipboard for future pasting without
deleting the selection. The Paste command places the
contents of the clipboard (if valid PBO Lab model data)
on the Work Space of the active Document Window. The
Delete command deletes any selected pieces from the
Document Window but does not copy them to the
clipboard. Deleted selections are permanently disposed.
There are also buttons in the Document Window Button
Bar that perform equivalent operations.

Numerical parameter values can be cut, copied and pasted
by pressing the right mouse button after a selection is made
in the edit field of the parameter. A contextual menu will
appear to the right of the edit field for the selection that
provides Cut, Copy and Paste commands. The number will
be stored on the clipboard when using cut or copy, replacing
any existing clip. The numerical clip can be pasted into
another numeric edit field or a text window. Figure 18 in
the Piece Windows Section illustrates an example of cut,
copy and paste commands for parameter data.

The remaining commands in the Edit Menu are used to
manipulate the beamline model. The Select All Pieces
command does exactly that: the entire beamline model is
selected in the Document Window Model Space. This can
be used with the Copy and Paste commands to store a
temporary copy of the beamline on the Work Space or to
copy the beamline to another Document Window.

Edit Menu.

Edit menu commands can be used
to copy and paste beamline pieces
within, and between, Document
windows.

There are buttons in the Document
window Button Bar for the standard
Edit menu commands. These
commands operate on a selection of
piece(s) in the beamline model.

Cut  Selection to 
the Clipboard

Copy  Selection 
to the Clipboard

Paste Clipboard 
on  Work Space

Delete Model 
Selection

Use the right mouse button after a
selection is made in a numerical edit
field in order to cut, copy or paste
numerical data.

Use the Select All Pieces command
to quickly select the entire beamline
model in the Document Window
Model Space. Note that Allias Pieces
can not be copied between
Document Windows, except when
using the Multiple Model mode (see
PBO Lab User Preferences).
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The last three commands in the Edit Menu, Alias Elements,
Make Subline and Flatten Subline, are beamline editing
features for configuring the beamline representation. The
Alias Elements command is used to create an Alias to the
current selection in the beamline model. The Make Subline
and Flatten Subline commands are used to collapse and
expand a selection of elements in the beamline. These
commands do nothing if a selection has not been made in
the beamline model. These beamline editing commands
are described in the Beam Line Construction Section.

View Menu
The third menu is the View Menu. The first command is
Hide/Show Palette, which allows the user to hide (or show)
the Palette Bar on the left edge of the Document Window.
The second command is Hide/Show Global Parameters,
which lets the user hide (or show) the beamline Global
Parameters in the Document Window.

The next group of commands in the View Menu contains
application-specific sub-menus for any installed PBO Lab
Application Modules, such as the Application Module sub-
menus shown in Figure 10. These sub-menus provide
quick access for viewing various native text files used by,
or created by, the different Application Modules that are
described in the individual Application Module
Supplements to the PBO Lab User Manual.

Figure 10.  View Sub-Menus for the TRANSPORT and
TURTLE Application Modules.

Figure 10 illustrates the View Menu for PBO Lab with
the TRANSPORT and TURTLE Application Modules
installed. When additional Application Modules are
installed, the View Menu will include sub-menus for those
modules as well.

An Alias is a component with a
persistent link to another component
in the beamline model.

Subline commands in the Edit Menu
can be used to group a selection of
elements into a single Subline
component in the beamline or to
flatten a Subline into individual
elements.

View Menu.

Hide or Show 
the Palette Bar

Hide or Show the 
Global Parameters

The Button Bar can also be used to
hide/show the Palette Bar and the
Global Parameters.
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The next item in the View Menu is the Tools sub-menu,
which contains two commands for opening data files
generated by the PBO Lab Focusing Module.  Refer to
the Analysis Tools Chapter for a description of these files.
The last two commands in the View Menu, Open Scratch
File and Physical Constants are not application-specific.
The Open Scratch File command is used to provide quick
access to a scratch text file that may be used for storing
any text data. The Physical Constants command opens a
window containing a variety of physical constants used
by PBO Lab and the different Application Modules.  This
window also includes a convenient list of common particle
masses that may be copied and pasted into the Global
Parameters Particle Mass field. Figure 11 illustrates the
Physical Constants Window.  The numerical values for
these constants can not be changed in this window.
However, the value fields are active (editable) to allow
these values to be copied to the system clipboard.

Figure 11.  Physical Constants Window.

Commands Menu
The fourth menu is the Commands Menu. The content of
this menu depends on which PBO Lab Application
Modules are currently installed. Any installed Modules

The Open Scratch File command is
used to provide quick access to a
scratch text file that may be used for
storing any text data.

The Physical Constants command
opens a window containing a variety
of physical constants used by PBO Lab
and the different Application
Modules.

Numerical values can be copied from
the Physical Constants Window using
the right mouse button to bring up a
contextual menu for a selected value.
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will include an application-specific sub-menu in the
Commands Menu. Individual commands for each of the
Modules are described in the respective Application
Module Supplements to the PBO Lab User Manual.

The last item in the Commands Menu is the Compute All
Auto Calcs command, which is application-independent.
This command will update all dependent beamline
parameters in Piece Windows that have alternative
parameter sets available. Refer to the Piece Window
Section  later in this Chapter.

Tools Menu
The fifth menu is the Tools Menu. The Focusing and
Bending commands in this menu access interactive tool
windows for single particle trajectories and beam envelopes.
These Tools are described in Chapter 4: Analysis Tools.
The next item in the Tools Menu is the Data Interchange
submenu. This is described separately in the External Data
Interface Section of Chapter 4 .  The last item in the Tools
Menu is for PBO Lab Preferences, which are described in
the Preferences Section of  Chapter 4.

Tutorial Menu
The last menu discussed in this Chapter is the Tutorial
Menu. This menu has three items. The first is the Hypertext
Tutorial command. This command opens the main PBO
Lab Tutorial Window, which contains a hypertext table of
contents for the tutorial help files available in PBO Lab.
The interactive tutorials and help features that are
integrated with the PBO Lab application are described in
Chapter 5. The second item in the Tutorial Menu is the
Register command, which opens the Registration Window.
Refer to the Registration Section in the Getting Started
Chapter for a description of PBO Lab registration. The
third item in the Tutorial Menu is the About command,
which brings up a window displaying PBO Lab credits
and version number.

The Commands, Tools and Tutorial
Menus are unique to PBO Lab and
are discussed separately in this User
Manual.

Commands Menu.

Tools Menu.

Tutorial Menu.

Launch HyperText Tutorials

Tutorial buttons in Piece Windows
provide access to specific interactive
physics tutorials for those pieces.
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The Button Bar
The Document Window Button Bar provides quick access
to a variety of File, Edit and View Menu commands.
Controls in the Button Bar are separated into four groups:
Document Window Operations, File Operations, Model
Editing Operations and Model Topology Operations. The
last button launches the Hypertext Tutorials. Figure 12
illustrates the different operational groups and the function
of each button.

The first control in the Button Bar specifies the Application
Context, which is used to provide feedback on the native
inputs for a particular application and to determine which
user interface windows will be opened for application-
specific inputs and options. The applications listed in the
application context pop-up depend on which Application
Modules are installed in your version of PBO Lab. Refer
to the PBO Lab Application Modules Section in the
Getting Started Chapter.

The remainder of the Button Bar controls duplicate various
File, Edit and View Menu commands. Refer to the
preceding Menu Bar Section for descriptions of the
different functions listed in Figure 12 below.

Launch HyperText Tutorials
Document Window Operations
Current Application Context
Hide or show the Palette Bar
Hide or show the Global Parameters

Model Editing Operations

Cut Model Selection to the Clipboard
Copy Model Selection to the Clipboard
Paste Clipboard Pieces on the Work Space
Delete Model Selection

Model Topology Operations
Convert Model Selection into Subline
Expand Subline Model Selection
Create Alias for Model Selection

Document File Operations
Create a New PBO Lab Document
Open a PBO Lab Document File
Close the Current PBO Lab Document
Save the Current PBO Lab Document

Figure 12.  Document Window Button Bar.

The Button Bar provides quick access
to a variety of File, Edit and View
menu commands.

The Application Context is used to
display and access application-
specific inputs for each of the
installed Application Modules.



PBO Lab 2.0 User Manual

31

The Palette Bar
The Palette Bar (on the left side of the Document Window)
contains Piece icons for each of the beamline elements
available in PBO Lab. Pieces are selected from the palette
and dragged to the Model Space of the Document Window
to “build” an accelerator beamline. The Palette Bar can
be toggled on and off from the View Menu or from the
Document Window Button Bar. The Palette Bar expands
with the height of the Document Window. Pieces that are
not visible are accessed by scrolling the Palette Bar.

Use Scroll Bar Arrow to 
Access all of the Palette 

Bar Pieces

Hold Mouse Down in 
Element Icons and 

Drag to Model Space

Button to
Hide/Show the 

Palette Bar

Figure 13.  Scrolling Palette Bar of Beam Line Elements.

Figure 13 illustrates a variety of different elements available
in PBO Lab. Some Pieces are specific to particular
Application Modules. The total number of Pieces in the
Palette Bar depends on the installed Application Modules.
PBO Lab will only use supported elements when generating
native inputs for a specific Application Module.

The scrolling Palette Bar contains
Piece icons for all of the beamline
elements available in PBO Lab.

Some Pieces in the PBO Lab Palette
Bar are specific to particular
Application Modules. Refer to the
individual Application Module
Supplements.
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Toggle the display of the Global
Parameters in the Document
Window from the View Menu . The
Button Bar also provides an
equivalent control to Hide or Show
the Global Parameters.

Beamline Global Parameters
The Beamline Global Parameters are the top level user
inputs for a beamline model in a PBO Lab Document
Window. They include specifications for the Particle
Charge, Particle Mass, Beam Energy, Beam Current and
Frequency, among others. The Global Parameters are
editable in three tab panels that float over the Work Space
area in the Document Window. Figure 14 illustrates all of
the inputs that are available in the three Global Parameter
tab panels: Globals, Tracing/Tracking and Floor
Coordinates.

Hide and Show the Global 
Parameters from the View 

Menu or the Button Bar

The Beamline Global Parameters 
are accessed from three tab panels 
that float over the Work Space of 

the Document Window

Figure 14.  Beamline Global Parameters in the Document Window.

Global Parameters that are native inputs for the different
Application Modules are indicated with green dots to the
right of those parameters. Green dots are based on the
current Application Context.
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The Maximum Step Size Global
Parameter is used by PBO Lab in the
Focusing and Bending Modules to
define the number of calculation
steps used for the ray trace and
envelope calculations.

Some Global Parameters are used by PBO Lab to calculate
dependent parameters, guidance limits and provide
numerical feedback for interactive Tutorial windows.
Table1 lists the PBO Lab Global Parameters and indicates
the different uses for these parameters by the different
Application Modules and by the PBO Lab user interface,
Tutorials and/or Tools.

Table 1.  PBO Lab Beamline Global Parameters.
P
B
O
L

T
R
A
N
S
P
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R
T

T
U
R
T
L
E

T
R
A
C
E
3
D

M
A
R
Y
L
I
E

Particle Charge

Particle Mass

Beam Energy

Beam Current

Frequency

Maximum Step Size

Beamline 
Global Parameters

Tracing/Tracking 
Parameters

Number of Macro Particles

Number of Tracking Turns

Output Distributions

Horizontal (x) Initial Location

Vertical (y) Initial Location

Longitudinal (z) Initial Location

Initial Yaw (y-axis) Angle

Initial Pitch (x-axis) Angle

Initial Roll (z-axis) Angle

Floor Coordinate 
Parameters

•• •• •

•• •• •

•• •• •
•• •• •

•• •• •

•• •• •

•• •• •
•• •• •
•• •• •

•
•
•

•
•
•

The Tracking/Tracing tab panel has parameters that are
used by the TURTLE and MARYLIE Application
Modules. These parameters are described in each of the
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The Floor Coordinates parameters are
used exclusively by the TRANSPORT
Application Module. Refer to the
Application Module Supplement for
a description of these parameters.

The Getting Started Section describes
the Model Space and Work Space in
the PBO Lab the Document window.

Connection Point

Pieces may be inserted into the
beamline at connection points
between pieces on the Model Space.

Organizing the beamline model using
Sublines provides room for more
pieces in the Model Space of the
Document Window.

Application Module Supplements for those applications.
Also included with the Global Parameters are a set of
initial floor coordinate parameters accessed from the Floor
Coordinates tab panel.  These parameters are used
exclusively by the TRANSPORT Application Module to
specify the initial coordinates and the orientation of the
reference trajectory.  Refer to the PBO Lab
TRANSPORT Application Module Supplement for a
description of these parameters.

The Model Space
The Model Space of the Document Window is where the
accelerator elements are placed to construct a beamline
model. Pieces are “dragged” to the Model Space from the
Palette Bar or the Work Space (discussed below). Pieces
from the Palette Bar may be placed on either the Model
Space or the Work Space. The first piece that is “dragged”
to the Model Space may be placed anywhere. Once the
first piece is placed, the following pieces “snap” on to the
end closest to where the piece was “let go” when the mouse
button was released.

Pieces may also be inserted between pieces in the beamline
by droping them at connection points in the beamline
model. Connection points are represented by lines between
elements in the beamline on the Model Space Pane. To
insert a piece, drag a selection over a connection point
and release the mouse button. The connection point will
be bold while the mouse is correctly located on it.
Releasing the mouse button inserts the selection in the
beamline model at that point. Note that there can never
be “loose” pieces in the Model Space. All pieces are either
inserted at connection points or snapped to an end of the
beamline model.

The scroll bar for the Model Space controls the positioning
of the model with respect to the window, and can be
adjusted by the user. The Model Space is large and can
accommodate a large number of accelerator elements. The
beamline assembled on the Model Space constitutes the
model whose data will be used in running the different
Application Modules.
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Drag a box around pieces with the
mouse to make a selection of
multiple pieces.

Pieces in the Model Space may be
cut, copied, and deleted using either
the Edit Menu commands, the
keyboard equivalents or the Button
Bar controls.

Alias Pieces can not be cut or copied
to another Document Window.

Delete Model Selection

Beamline information for copied or
cut pieces is retained on the clipboard
as a PBO Lab subline description.

Copy Model Selection 
to the Clipboard

Cut Model Selection 
to the Clipboard

Paste Clipboard Pieces 
on the Work Space

Pieces may be moved within the
beamline by holding down the shift
key while dragging the selection to
a new location in the beamline.

A selection of multiple pieces is made by using the mouse
to enclose the desired selection with a drag box. Hold down
the mouse button while dragging a box around the desired
selection. Release the mouse button and the pieces within
the box will be selected. The Model Space will scroll
automatically while dragging a box that exceeds the
currently visible beamline elements. To select the entire
beamline model, use the Select All Pieces command in the
Edit Menu.

A single piece or group of pieces may be selected and
copied, cut or deleted using the appropriate commands
from the Edit Menu. These actions are very similar to the
standard Copy, Cut and Delete actions of many other
applications. The keyboard equivalents of the Edit Menu
commands are the standards for your particular platform.
The Delete action removes the selected pieces from the
beamline model. All information associated with these
pieces is permanently disposed.

The Copy action makes a copy of the selected pieces and
associated information (parameter settings) and stores that
data on the clipboard. The pieces may later be pasted onto
any Document Window. The original pieces and the data
associated with them are unaffected in the source
Document Window. The Cut action is similar to the Copy
action, except that the original pieces and associated data
are deleted from the Document Window. Cut makes a copy
of the pieces and associated information and stores it on
the clipboard. The pieces may then be pasted on to any
Document Window. The Paste action will place the
contents of the clipboard (if it is valid piece data from a
previous cut or copy) on the Work Space of the current
Document Window. The piece(s) will appear in the lower
left corner of the Work Space. (The Work Space is
discussed in the following Section.)

A single piece or a selection of pieces may be dragged from
the Model Space to the Work Space. This action
automatically creates copies of the piece(s). The original
pieces and the data associated with them are unaffected and
remain on the Model Space. To move a piece or group of
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Dragging piece selections between
the Model Space and the Work Space
automatically generates a copy of the
selection.

The Work Space can be used to store
Pieces, Sublines and selections of
Pieces and Sublines as illustrated in
Figure 15. Beamline fragments on the
Work Space are saved with the
Document but are not considered
part of the beamline model.

The Work Space is most helpful when
used in conjunction with the Model
Space.

Hide or Show the Palette Bar
in the Document Window

Hide or Show the Beam Line
Global Parameters

pieces from one position in the beamline to another position,
hold down the shift key while dragging the selection to a
new location in the beamline model.  The arrow will
change to a small piece icon with the word “move”. When
the mouse button is released over a connection point in
the beamline, the selection will be deleted from its original
location and inserted in the new location.  Pieces can also
be moved between the Work Space and Model Space using
the shift key.

The Work Space
The Work Space is the shaded area of the Document
Window. Additional Work Space may be accessed by
“hiding” the Global Parameters and the Palette Bar as
shown in Figure 8 and in Figure 15 below. This may be
done from the Button Bar or from the View Menu.

Figure 15.  “Hiding” the Global Parameters and the
Palette Bar in the Document Window.

Pieces may be placed on the Work Space either by dragging
them from the Palette Bar or the Model Space. When a
piece or a group of pieces is dragged from the Model Space
to the Work Space, it can be placed anywhere on the Work
Space. Pieces are not grouped on the Work Space unless
they were grouped prior to being placed on the Work Space.
No pieces are inserted into a model structure when placed
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When a Paste command is executed,
the existing set of Pieces currently on
the clipboard will appear on the Work
Space. They may then be dragged to
the beamline in the Model Space.

Drag Bar for Selection 
in Work Space

Selections made on the Work Space
can be moved while holding the
mouse button down on the drag bar
of the selection.

Pieces stored on the Work Space are
persistent until deleted by the user.
The contents of the Work Space is
retained in the model file when a
Save, or Save As, command is
executed.

Refer to the Alias Piece Section later
in this Chapter.

on the Work Space. A group of pieces placed on the Work
Space will remain in their original configuration and cannot
be separated on the Work Space. (Of course, they can be
dragged to the Model Space, a subset selected, and then
that subset placed on the Work Space.) A piece or a group
of pieces may also be copied, cut or deleted from the Work
Space with the same result as in the case of the Model Space.
Any existing data on the clipboard will be erased when
either copy or cut is executed.

If a piece or group of pieces have been previously copied
or cut from either the Work Space or the Model Space,
they may be placed on the Work Space by pasting them
from the clipboard. The Paste action is similar to that of
other applications. Once pieces have been pasted to the
Work Space, they may then be dragged to the beamline in
the Model Space.

There may be many individual “loose” pieces or groups of
pieces on the Work Space as shown in Figure 15. These may
be moved around and located on the Work Space as desired.
Selections on the Work Space are dragged by clicking on the
drag bar and holding the mouse button down while dragging
the selection. Selections in the Work Space have a Red Drag
Bar; unselected items have a Blue Drag Bar. These Work
Space pieces are not part of the beamline model and these
Pieces are not used when an Application Module command
is executed. Only the pieces on the Model Space of a
Document Window are used to define the beamline model
input. However, Global Parameters associated with the model
are utilized for Work Space pieces, for example, in displaying
“smart units” for the input parameters of these pieces. The
Work Space pieces are retained when a model is saved using
the Save or Save As commands from the File Menu (Figure
9) or the Button Bar (Figure 12).

The Work Space can be used for several purposes; for
example, to store a repeated set of pieces that will be used
several times in a beamline. The parameters of pieces on
the Work Space may be set independently of the beamline
pieces on the Model Space and are not affected by changes
to the beamline model, with the exception of Alias pieces.
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Piece Windows
Input parameters for beamline elements are accessed in
PBO Lab Piece Windows. Figure 16 illustrates double-
clicking a Quadrupole Piece icon in the beamline model
to open a Quad Piece Window. Piece Windows can be
opened for pieces in the Model Space and Work Space as
well as Subline Windows or Focusing and Bending
Module Windows.

Piece Windows are Opened by 
“Double-Clicking” the Mouse while 

the Cursor is on the Desired Piece 

Figure 16.  Opening the Piece Window for a Quadrupole Element.

Each Piece Window contains a Title Bar with Close Box, a
Button Bar and one or more parameter data records. Some
Piece Windows have tab panels that provide access to
additional parameters, such as the Quadrupole Piece Window
shown in Figure 16. Each parameter data record includes
four fields of data: (1) a word description of the Parameter,
(2) a Value field for entering numerical data or a pop-up
selection menu, (3) a Units field that provides options through
pop-up menus and (4) Limits fields, which provide input
guidance using a set of knowledge-based rules.

Many parameters also have a Special “S” button that is used
to open a Special Parameter Settings Window for specifying
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Most Piece Windows have multiple
tab panels that provide additional
inputs such as location and geometry
parameters.

Default values are defined for all
piece parameters so that a complete
set of native input data is defined
automatically for any Application
Module when a piece is placed in the
beamline model.

application-specific options, such as selecting a parameter
as a fitting or import variable or defining an algebraic
expression for the parameter. An example of a Special
Parameter Settings Window is shown in Figure 17. The “S-
Windows” have Application tab panels that provide access
to application-specific options for installed Application
Modules. These are described in the individual Application
Module Supplements to the PBO Lab User Manual.

Figure 17 illustrates several features of the PBO Lab Piece
Windows that are described in this Section. Default values
are defined for all parameters so that both the topology of
the beamline and a complete set of input data are defined
automatically when a piece is placed in the beamline model.

Native Inputs for the 
Current Application 
Context are Indicated 

with Green Dots

Tab Panels Provide 
Access to Additional 
Element Parameters

Many Parameters 
have a "S" (Special) 
Button for Opening 
Special Parameter 
Settings Windows

Tutorial Button 
Accesses Physics 
and Technology
Tutorial for Piece

Application-Specific 
Tab Panels for Special 

Parameter Settings 

Different Units Options Are 
Available for Most Parameters

Guidance Limits Alert User 
if Parameters Are Outside 

Reasonable Bounds

Comments May Be 
Used to Label Pieces 

Select Among Alternate 
Parameter Sets

Figure 17.  Piece Window for the Sector Bend (SBend) Element.
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Green dots appear to the right of
Piece Parameters to indicate the
native inputs for the selected
Application Context.

All Piece Parameters have built in
defaults. However, to minimally
define a Piece for a specific
Application Context, review the
green dot (native) parameters.

All Piece Parameters have default
values built-in so that an element is
defined automatically when it is
placed in the beamline model.

The Piece Window Button Bar (at the top of the Piece
Window) includes a Tutorial button for many of the
beamline elements, such as the Sector Bend shown in
Figure 17. Other application-specific buttons may be
found for installed Application Modules. These are
described in the individual Application Module
Supplements to the PBO Lab User Manual.

The Green Dots to the right of some parameters indicate
which parameters will be used as native inputs for the
Application Module that is currently selected in the
Application Context pop-up. To examine the native
parameters for a different application, simply leave the Piece
Window open and change the Application Context in the
Button Bar of the Document Window. The green dots are
for application-specific feedback only. Switching the
Application Context has no effect on piece parameters. A
parameter is not required to be an active (editable) parameter
in order to be used as native input. It may be calculated
from related parameters that have been chosen to define a
Piece. Alternate Parameter Sets are described later in this
Section.

The primary beamline Element parameters are always
displayed on the front tab panel in a Piece Window, as
shown in Figures 16 and 17 for the Quadrupole and Sector
Bend. Additional (secondary) parameters may be included
in other tab panels as illustrated for the Quad Piece
Window in Figure 6 of the Getting Started Chapter. Most
Application Modules require only a subset of the primary
element parameters (indicated with application-specific
green dots). Secondary parameters may be used for a
variety of calculations in PBO Lab Tutorials and Tools
and for some application-specific inputs.

All parameters have built-in defaults. A piece is completely
defined for all Application Modules when it is placed in the
beamline model. PBO Lab will generate the required native
inputs in the appropriate format and syntax for installed
Application Modules. To minimally define an element for a
specific Application Module, select that application in the
Application Context pop-up and review the default values
for the green dot (native) element parameters.
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All of the numerical inputs in a Piece Window are entered
in parameter Value fields. When a number is changed in a
Value field and the “Enter” key is pressed, the new number
is immediately updated and any limits or auto-calculated
dependent parameters related to that parameter are also
updated. A value will also be updated when the mouse is
clicked outside the Value field or if the window is closed.
However, using the Enter key is the recommended
procedure to update a parameter value in order to examine
updated guidance limits and any dependent parameters.

Numerical values may be cut, copied and pasted using
the right mouse button to bring up a contextual menu as
shown in Figure 18 below.

Figure 18.  Cut, Copy and Paste of Numeric Values.

The user may select different units for a parameter by
choosing the appropriate option from one of the Units
field pop-up menus. Several pop-up menus include “smart
units.” These are units that scale dynamically with certain
Global Parameters and other parameters from Piece
Windows. For example, all parameters that have the
dimensions of length include “β-Lambda” as a units option
(Figure 17). The value of the β, the relativistic velocity
parameter of the particle, is determined by the Global
Parameter values for the Particle Energy and Particle Mass,
while the value of l is set by the Global Frequency
Parameter.

Piece Windows also contain lower and upper guidance
“limits” for each parameter. These guidance limits are
not used to restrict the input. Any value may be entered
for a parameter.

After entering a numerical value, use
the “Enter” key to accept that value.

Copy and paste in Value fields using
the right mouse button to bring up a
contextual menu.

Most parameters provide a variety of
units options including dynamic
“smart units”.

Guidance limits are displayed for each
Piece Parameter. However, the
guidance limits are “soft”, and any
value for an input parameter may be
used.
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The Quadrupole Strength pop-up is
used to toggle between parameter
sets in the Quad Piece Window
(Figure 16).

The Dipole Strength pop-up used to
toggle between different parameter
sets in the Sector Bend Piece Window
(Figure 17).

The beamline model must start with
a  Beam Piece  in order to generate
the initial beam for the Focusing and
Bending Modules.

The guidance limits are intended to provide estimates of
a practical range for a parameter value based on beamline
Global Parameters and possibly other parameters in the
Piece Window.

Some Piece Windows contain more than one parameter set
for specifying a beamline element. Top level pop-ups above
the parameter header in Piece Windows are used to activate
alternate parameter sets for specifying an element. For
example, the Quadrupole Strength in the Quad Piece
Window shown in Figure 16 and the Dipole Strength in the
Sector Bend shown in Figure 17 both provide alternate
parameter sets for these elements. Parameter Value fields
are activated (editable) and deactivated (non-editable) based
on the parameter set selection. Inactive, dependent
parameters are auto-calculated based on active user editable
parameters. PBO Lab indicates which parameters will be
used for the current Application Context. However, it is
possible to specify an element for a particular Application
Module using a parameter set that is not supported by that
application. PBO Lab will auto-calculate the required inputs
for specifying an element in the native format required for
each Application Module.

Beam Piece
PBO Lab uses the Beam Piece to generate the initial
beam for the Trajectories Module described in Section
4 PBO Lab Analysis Tools. The Beam Piece can be used
to specify the initial beam in two different ways, referred
to as the Semi-Axes representation and Courant-Snyder
(Twiss) parameter representation.  The Semi-Axes
representation is more general and allows for the
complete specification of the beam sigma matrix,
including correlations between different phase planes.
The Twiss parameter representation is useful for
specifying initial beams in which the phase planes
(horizontal, vertical and longitudinal) are decoupled.
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Both the Semi-Axes and Courant-Snyder (Twiss) input
panes are shown in Figure 19 for the Beam Piece window.
There is a Button Bar at the top of the window, two tab
panels for parameter inputs (Beam and Centroid
Parameters) and a set of dynamic phase space ellipse plots
for the beam parameters. The Particle Distribution Type
pop-up is used to generate multi-particle distributions for
certain Application Modules (e.g. TURTLE, MARYLIE).

Transverse and Longitudinal 
Phase Space Ellipse Plots are 
Provided for Beam Parameters

Select between Semi-Axes or 
Courant-Snyder (Twiss) Beam 

Parameter Representations

The Tutorial Button Opens the 
Beam Piece Tutorial Window, 

which Provides a Variety of 
Information on Beam Parameters

Green Dots Indicate which 
Parameters will be used to 

Generate the Native Inputs for 
the current Application Context

Open the Correlations Matrix Window with 
Semi-Axes Parameters Selected

Compute Semi-Axes Parameters from Twiss Parameters
or Compute Twiss Parameters from Semi-Axes

Auto-Scale Phase Space 
Ellipse Plots or Set the 

Plot Scales Directly

Figure 19  Semi-Axes and Courant-Snyder (Twiss) Beam Piece Parameters.
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When the Twiss Beam Parameters are selected, the
Compute From Semi-Axes button will calculate the
equivalent Twiss parameters for the current Semi-Axes
parameters.  When the Semi-Axes parameter set is selected
the Compute From Twiss button will calculate the
equivalent Semi-Axes parameters for the current Twiss
parameters.  The Compute From... button is in the Button
Bar at the top of the Beam Piece Window.

When Semi-Axes Beam Parameters are selected,
correlations may be included in the beam description using
the Correlations button in the Button Bar of the Beam Piece
Window.  The Correlations button opens the Correlation
Matrix Window shown in Figure 20.  Correlations may be
entered directly as off-diagonal elements of the sigma-
matrix, or by entering values for the reduced sigma matrix.

Select between Sigma Matrix or 
Reduced Sigma Matrix inputs

Figure 20  Beam Correlation Matrix Window.

The Beam Piece window includes dynamic phase space
ellipse plots for the current beam parameters.  The top
plot shows the horizontal (red) and vertical (blue)

The Green dots to the right of
individual parameters indicate which
will be used to generate TRANSPORT
input.

With the Semi-Axes Beam Parameters
representation  correlations may also
be included  in  the  beam description.

The   Beam   Correlations Matrix
Window is opened with the
Correlations button in the Beam Piece
window.

Correlations may be entered  directly
as off-diagonal  elements  of  the
sigma-matrix,    or    by entering  values
for  the reduced  sigma  matrix.
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transverse phase space ellipses.  The bottom plot is the
longitudinal phase space ellipse.  The axis scales for the
phase space ellipse plots can be calculated automatically
with the Auto Scale Plots button in the Button Bar at the
top of the window or the scales may be set directly by the
user with the Set Plot Scale button.

Beam Line Construction
The PBO Lab environment uses a sophisticated beamline
object model for the persistent storage and graphic
representation of beamline models. The beamline object
model supports both flat and hierarchical beamline
topologies and is used to generate the native beamline
descriptions for each of the Application Modules supported
by PBO Lab. A flat model description refers to a beamline
model in which every component is represented by an
individual element in the model. With a hierarchical model,
the beamline topology is organized using sublines that
encapsulate multiple elements in the beamline model.

The object model also supports the ability to create Alias
Pieces. An Alias Piece can be created for an individual
piece, a subline, or a selection of multiple pieces and
sublines in the beamline model.

An Alias is a component with a persistent link to another
component and is capable of storing deviations from the
original data without duplication of redundant data. A
number of benefits can be realized using sublines in
combination with the ability to create Aliases, including
more efficient problem setup, compact views of very large
models and elimination of redundant data storage within
highly symmetrical beamlines. Refer to the Alias Section
later in this Chapter for more information on Aliases.

The Beam Piece Windows include
phase space ellipse plots for the
current Beam Parameters.

The beamline object model supports
both flat and hierarchical beamline
organization and is used to generate
the native beamline descriptions for
each of the Application Modules
supported by PBO␣ Lab.

An Alias is a component with a
persistent link to another component.

An Alias is capable of storing any
deviation from the original parameter
data without duplicating any of the
redundant data.
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Sublines
A Subline is created by making a selection in the
beamline model and then choosing the Make Subline
command in the Edit menu or by pressing the Subline
button in the Document Window Button Bar. The
selection will be replaced with a single Subline icon in
the beamline model. Figure 21 illustrates making a
selection of pieces and grouping those pieces into a
subline.

A Subline is Created for the 
Selection in the Beam Line Model

Make a Selection of Elements in 
the Model Space and then Choose 

the Make Subline Command in 
the Edit Menu or in the Button Bar 

of the Document Window

Figure 21.  Making a Subline in the Beam Line Model.

Sublines can only be created for selections in the Model
Space. However, sublines can be stored on the Work
Space by dragging a copy from the beamline model.
Sublines may be nested to any level (i.e. a subline may
contain other sublines).

Figure 22 illustrates double-clicking a Subline icon to open
a Subline Window. The Subline Window provides access
to the individual pieces inside the subline.

Encapsulate  a Selection 
into a Subline 

A Subline is created by making a
selection in the beamline model and
then choosing the Make Subline
command in the Edit Menu or by
pressing the Subline button in the
Document Window Button Bar.

To select a set of element icons that
extends beyond the visible portion of
the Model Space Pane, hold down
the Control (Ctrl) key, select the
elements, and then scroll the Model
Space Pane to access and select
additional elements.

Double-click a Subline icon to open a
Subline Window in order to access the
individual pieces inside the subline.
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Figure 22.  Opening a Subline in the Beamline Model.

A subline can be expanded (flattened) to restore individual
element representations in the beamline model by
selecting a Subline and then choosing the Flatten Subline
command in the Edit Menu or by pressing the Flatten
button in the Document Window Button Bar.

Creating Sublines does not alter the components within the
Subline; only the beamline topology is affected. Although
some Application Modules do not support hierarchical
beamline representations in their native beam line description
formats, PBO Lab will generate a flat description from a
hierarchical representation when necessary.

Expand (Flatten) the 
Selected Subline 

To expand a Subline, select it and
choose the Flatten Subline command
in the Edit Menu or the Button Bar
of the Document Window.
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Aliases
An Alias in PBO Lab is a beamline component defined
by a persistent and dynamic link to another beamline
component, where “component”, as used here, refers to
either a single Piece, a Subline or a selection of multiple
Pieces and/or Sublines. An Alias can be created for a
selection in the beamline model and is capable of storing
deviations from the original data without duplication of
redundant data. When the parameters of the original
component are modified, the changes are realized in all
Aliases that reference that component and any specified
deviations are applied.

An Alias is created by making a selection in the beamline
model and then choosing the Alias Element(s) command
in the Edit Menu or by pressing the Alias button in the
Document Window Button Bar. An Alias will appear in
the Work Space for the selected model pieces. (The new
Alias placed on the Work Space may be partially covered
by the beamline Global Parameters.) Alias components
are easily identifiable by the red letter “A” appearing on
the Piece icon.

Once an Alias has been created on the Work Space, it
may be placed in the beamline model by dragging a copy
to the Model Space and inserting it between elements or
at either end of the beamline model. The original
component referenced by an Alias is not affected when
the Alias is created. However, the original component
cannot be deleted until all Aliases that reference it have
been deleted. The original component referenced by an
Alias is accessible from the Alias Window using the
“Original Element” button at the top of the Piece Window.
Pressing this button will open the Original Piece Window
referenced by the Alias.

When an Alias is initially created, none of the Alias
Parameters have any deviation from the original
component, in effect creating an identical representation
of the original component. This is a common usage for
Aliases in large models with many duplicated elements.

An Alias is a component defined by
a link to another component in the
beamline model.

An Alias is created by first making a
selection in the beamline model and
then selecting the Alias Element
command in the Edit Menu or by
using the Alias button in the Button
Bar of the Document Window.

Create an Alias Piece 
for a Model Selection

A A

Aliases are easily identified by the red
letter “A” that appears on the piece
icon.

The original component referenced
by an Alias is accessible from the Alias
Piece Window using the “Original
Element” button at the top of the
window.

When an Alias is initially created, by
default there are no deviations from
the original piece parameters.
Parameter deviations must be
explicitly assigned in an Alias Piece
Window.

Any modifications to original
parameters are automatically realized
in all Aliases of that element.
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Table 2 describes the different options available for
specifying parameter deviations for an Alias or over-riding
a parameter value completely.

Table 2.  Parameter Deviation for Alias Pieces.

Deviation Description

No Deviation (default) There is no deviation from the original parameter value:
Alias parameter = original parameter value

Deviation The specified Error value is taken to be a numerical deviation:
Alias parameter = original value + Error

% Deviation The specified Error value is taken to be a percent deviation:
Alias parameter = original value + original value*(Error/100)

Actual Value The specified Error value is taken to be the actual value:
Alias parameter = Error

To include a deviation for a particular parameter, double-
click the Alias Piece icon to open the Alias Piece Window.
If the Alias is a subline, open the Subline Window and
then open the individual Piece Window for the Alias from
within the Subline Window. A typical example is shown
in Figure 23 for a Quadrupole Alias, which has a percent
deviation of 0.02 kG on the Magnetic Field Parameter.
The original value for this parameter is 3.0 kG, the Error
is 0.1 and percent deviation has been selected. This defines
a Quadrupole that is identical to the original, with the
exception of the Magnetic Field Parameter, which is taken
to be 3.003 kG (3.0 + 3.0*(0.1/100)). Any modifications
to the original Quadrupole parameters will automatically
be realized in all Aliases of that element. This is also true
for inputs that have been specified as variable parameters
in the original element. For example, the Length Parameter
of the original Quad could have been set to vary during a
fitting operation. The Length will be variable in all Aliases
to that Quad during fitting, but each Alias Quad could
still have different values specified for other parameters.
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There are some restrictions on Alias Pieces, for example, an
Alias can be duplicated in a Document Window by dragging
a copy from the beamline model to the Work Space, but it
can not be cut or copied with Edit Menu commands or
with the Button Bar controls.     However, if the PBO Lab
application is started in the Multiple Document Mode
(refer to the PBO Lab Preferences Section) Aliases can
be copied and pasted between different Document
Windows.

Tab Panels for additional parameter inputs

Access Interactive Physics Tutorial for this Element

Access Original Element referenced by this Alias

Popup for alternative parameter inputs

The "Error" or deviation that will be used  for each parameter

The original Parameter Value
(Editable in the original element referenced by this Alias)

The "type" of deviation, e.g. how the Error will be applied

Green Dots Indicate Native 
Inputs for the Current 
Application Context

Figure 23.  Example of a Piece Window for a Quadrupole Alias.

For a description of application-specific user interface
features and commands, refer to the individual Application
Module Supplement distributed with each Module. The
following two Chapters describe the PBO Lab Analysis
Tools and interactive Tutorials.

PBO Lab 2.0 User Manual
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This Chapter describes the PBO Lab Focusing and
Bending Modules, Plot Tools, Data Interchange Tools and
PBO Lab Preferences.

Focusing & Bending Modules
Single particle trajectories and beam envelopes may be
analyzed using the PBO Lab Focusing and Bending
Modules, accessed from the Tools Menu. The Tools pull-
down menu is illustrated in Figure 24 and contains two
options (Focusing and Bending) that are described in this
Chapter.

Brings Up an Interactive Display for 
Horizontal and Vertical Projections

Brings Up an Interactive Display for 
Magnetic Mid-Plane Projections

Figure 24.  PBO Lab Tools Menu.

The PBO Lab focusing and bending tools use a first-order
optics code developed to support interactive graphical
displays of single particle trajectories and beam envelopes.
They are independent of installed Application Modules
and running the tools is not required to set up or execute
any of the Application Modules.

The Focusing and Bending Modules do not utilize any of
the PBO Lab Application Modules for computations.
However, beamline parameter values can be modified
while using the interactive Analysis Tools, which can result
in different numerical data (e.g. drift lengths, bend and
edge angles) assigned to the elements in the beamline
model.

It is recommended that you save your work prior to making
any adjustments in the Focusing and Bending Modules
Windows since changes will be reflected in the beamline
model.

Single particle trajectories and beam
envelopes may be computed and
displayed using the PBO Lab
Focusing and Bending Modules.

A built-in first-order optics module is
used to support the interactive
graphical displays of single particle
trajectories and beam envelopes in
the Focusing and Bending Modules.

Element parameter values in the
beamline model of the Document
Window can be modified while using
the interactive Piece Sliders of the
Focusing Module or the Angle Dials
of the Bending Tool.  It is
recommended that you save your
work prior to making any
adjustments in these Tool Windows.

PBO Lab 2.0 User Manual
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Interactive Scaled Image of the Beamline  
(Drag Sliders with the Mouse to 

Interactively Adjust Drift Lengths)

The Button Bar Provides  Controls to Access Initial 
Particle Parameters, to Control Ray Trace and 
Envelope Plots, to Clear or Print Plots and to 

Toggle the Piece Sliders on and off

The Iconic Representation of the Beamline 
Model can be used to Open Piece Windows 

and Edit Element Parameters

Figure 25.  Focusing Module Window.

Focusing Module
The Focusing command in the Tools Menu opens a focusing
tool window entitled Transverse Projections of a Particle
Trace. The primary components of the Focusing Module
Window are illustrated in Figure 25 and include a button
bar, an iconic representation of the beamline model, an
interactive scaled image of the beamline model, transverse
phase space ellipses, Twiss parameters and beam cross
section. The horizontal and vertical projections of a particle
trace with the specified initial coordinates are graphed over
the scaled image of the beamline model as illustrated in
Figure 26.

The Focusing Module uses a built-in first-order optics code
to graphically illustrate the qualitative optical features of a
beamline. This module is not intended to be as accurate as
the Application Modules available in PBO Lab.
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The Button Bar at the top of the Focusing Module Window
contains buttons for Initial Particle specification, particle
Ray Trace, beam Envelopes, Clear, Print and Toggle
Sliders. The iconic representation of the beamline is
identical to that on the Model Space of the Document
Window. Central in the Focusing Module Window is the
layout of the beamline model, with all distances along the
beamline (moving horizontally) and the apertures of the
elements (shown vertically) drawn to scale. Effective drift
lengths can be adjusted graphically with Piece Slider
controls along the beamline. At the bottom of the window
is a transverse phase space ellipse and beam cross section
display. The beam x (horizontal) and y (vertical) envelopes
are displayed by selecting the Envelopes button. The result
is shown in Figure 26 below.

Transverse Phase Space Ellipses and Beam 
Cross Sections are Plotted  with Envelope 

Calculation and can be Played Back for Each 
Step through the Beamline

Corrant-Snyder (Twiss) Parameters are Displayed 
for each Step through the Beamline

(Plot Scales are Displayed for Phase Space 
Ellipses and Beam Cross Section)

Figure 26.  Envelopes in the Focusing Module Window.

The plot of each plane’s envelope and
phase ellipse are color coded as
indicated in the legend. The horizontal
envelope and phase space ellipse are
all plotted in red. The corresponding
vertical plots are displayed in blue.
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Default Parameters are Provided 
in the Initial Particle Window

Space Charge can be Applied 
to the Ray Trace Calculation 
with a Non-Zero Beam Current

Space Charge is Always Applied 
to the Envelope Calculation when 

Beam Current is Non-Zero

Horizontal and Vertical Projection 
of a Single Particle Ray Trace

Figure 27.  Particle Ray Trace in the Focusing Module Window.

When the Space Charge check box has been checked in
the Initial Particle Window, linear space charge forces,
determined by the Beam Current Global Parameter, are
included in the equations used for the Ray Trace
calculations. Space charge forces are always included in
the Envelope calculations if the Beam Current Global
Parameter is non-zero.

The beam x (horizontal) and y (vertical) projection of a
single particle trace are displayed by selecting the Ray Trace
button. The result is shown in Figure 27 below. The plot of
each plane’s trajectory are color coded as indicated in the
Legend. The horizontal projection is plotted in red and the
corresponding vertical projection is displayed in blue. The
Initial Particle Parameters are accessed with the Initial
Particle button in the Button Bar at the top of the Focusing
Module Window.

Initial Particle Parameters are
accessed in a separate window that
is opened with the Initial Particle
button in the Focusing Module
Window.

Space Charge forces are included in
the ray calculations when the Space
Charge check box is selected in the
Initial Particle Parameters Window
and the Beam Current Global
Parameter is non-zero.
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A number of qualitative features of the transverse optical
properties for a beamline may be examined using the
focusing tools. Two types of Slider Controls are included
in order to interactively study a beamline. Individual Piece
Sliders allow the user to move the position of the optical
elements along the beamline. Figure 28 shows these Piece
Sliders in the Focusing Window.

Piece Slider Controls are Used to 
Interactively Adjust the Positions 

of Pieces in the Beamline

The Toggle Sliders Button will Hide 
and Show the Piece Slider Controls

Drag a Piece Slider with the 
Mouse to Adjust Drift Lengths 

on Both Side of the Piece

PIECE SLIDERS WILL CHANGE DRIFT 
LENGTHS IN THE BEAMLINE MODEL!

(It is Recomended that you backup your Model 
File Before Adjusting Piece Sliders or use the 
Work Space to Store a Copy of the Beamline)

Figure 28.  Using the Piece Slider Controls.

Using the Piece Sliders to adjust the locations of elements
causes a change in the lengths of the adjacent drift
elements. This will result in a modification of the drift
lengths in the beamline model. An example of the use of
the Piece Sliders would be to adjust the initial positions
of certain optical elements to achieve graphically (or
qualitatively) a particular feature of the envelopes, or of a
particle trajectory such as that for a characteristic ray.
However, in order to avoid any inadvertent changes in the
drift lengths contained in an important file, it is
recommended that the file be saved before making any
Piece Slider adjustments.

Piece Sliders move optical elements
back and forth along the beamline.

The Toggle Sliders button hides and
shows the Piece Sliders in the
Focusing Module Window.

After making Piece Slider
adjustments, either the Ray Trace or
Envelope button can be used to
update the display on the scaled
image of the beamline model.

It is recommended that the file be
saved before making any Piece Slider
adjustments.
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The second type of Slider Control is the Envelope Slider,
which is used to select the location in the beamline where
the phase space ellipses and beam cross section are
displayed. The Envelope Slider has additional control
buttons located at each end of the slider. Figure 29
identifies these controls, which can be used to (1)
discretely step through the beamline (right control
buttons), or (2) move continuously and automatically
through the beamline (left control button). When the
continuous play (left) button is selected, the Envelope
Slider control moves from left to right across the central
pane, while the lower pane provides an animated display
of the phase space ellipses and beam cross section,
corresponding to the Envelope Slider control location.

The Envelope Slider is used to select
a location in the beamline model for
displaying the phase space ellipses
and beam cross section.

Using the Envelope Slider controls will
not result in any modifications to
beamline element parameters.

Use this Button to Animate the Phase 
Ellipses and Beam Cross Section 
Forward through the Beamline, 

Similar to Playing a Movie

Use this Button to Step the Phase 
Ellipses and Beam Cross Section 

Backward One Frame at a time

The Transverse Twiss Parameters 
are Displayed for Each Step 

Through the Beamline

Use the Thumb Control Button 
to Show the Phase Ellipses and 

Beam Cross Section at a Specific 
Location in the Beamline

Use this Button to Stop 
the Animated Play Back

Use this Button to Step the Phase 
Ellipses and Beam Cross Section 

Forward One Frame at a time

Use this Button to Animate the Phase 
Ellipses and Beam Cross Section 
Backward through the Beamline

Figure 29.  “Playing” the Envelopes Like a Movie.
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The Corrant-Snyder (Twiss) parameters corresponding to
the phase space ellipses are displayed for each step through
the beamline as illustrated in Figure 29.  This data is also
written to the “TwissParameters” disk file that can be
opened from the Tools sub-menu in the View Menu of the
Document Window.  The envelope and ray data is written
to the “EnvelopesAndRays” disk file, which is also opened
from the Tools sub-menu.  Writing these files can slow
down the ray and envelope calculations so preferences
are provided to disable this feature.  The Focusing and
Bending tab panel in the PBO Lab Preferences window
has options to disable the writing these files. (Refer to the
PBO Lab Preferences Section in this Chapter.)

The number of steps used for calculating the rays and
envelopes depends on the Maximum Step Size Global
Parameter, which is the last parameter in the Globals tab
panel in the Document Window.  The number of discreet
steps is derived from the overall beamline length and the
Maximum Step Size Global Parameter.  The total number
of steps and the current step are shown in the Focusing
Module Window above the Twiss parameters display.  In
Figure 29 the Envelope Slider control has been placed at
step 28  of 103 discrete steps for the entire beamline.
Below the display of Twiss parameters, the horizontal and
vertical plot scales are shown for the phase space ellipses
and beam cross section plots.

The overall beamline length is displayed in the lower right
corner of the Focusing Module Window along with a
scalable value for the Height of the beamline image.  The
Height represents the distance from the center line in the
scaled image of the beamline model and can be changed
without recalculating the rays and envelopes.

Focusing data files are accessed from
the Tools sub-menu in the View
Menu of the Document Window.

The step size used in the ray and
envelope calculations is based on the
Maximum Step Size Global Parameter
in the Globals tab panel in the
Document Window.
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Bending Module
The Bending command in the Tools Menu brings up a
window entitled Magnetic Mid-Plane Projections of a
Particle Trace. An example of the Bending Module
Window is shown in Figure 30 below.

Scaled Image of the Beamline Model 
Showing Bend Angles from a Top View

The Button Bar Provides  Controls to Access Initial 
Particle Parameters, to Control Ray Trace and 

Envelope Plots and to Clear or Print Plot

The Iconic Representation of the Beamline 
Model can be used to Open Piece Windows 

and Edit Element Parameters

Bend and Edge Angle Controls
(Select a Bend in the Iconic Representation and 
use the Controls to Interactively Adjust Bend 

and Edge Angles for the Selected Piece)

Figure 30.  Bending Module Window.

The example illustrated in Figure 30 shows the magnetic
mid-plane projection for both the reference trajectory and
the single particle ray. The reference trajectory and the
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single particle ray are drawn with the RayTrace button.
The magnetic mid-plane projection of the beam envelope
is drawn using the Envelope button.

The Bending Module uses a built-in first-order optics code
to graphically illustrate the qualitative optical features of a
beamline. The trajectories module is not intended to be as
accurate as the Application Modules available in PBO Lab.

The layout of the Bending Module Window is similar to
that of the Focusing Module Window. The principle
difference is in the central pane of the window, where an
image of the magnetic mid-plane for the beamline is
drawn. All bends are viewed perpendicular to the plane
of the bend in this type of plot. The reference trajectory
lies in the magnetic mid-plane. The bending tool traces
out this reference (or central) orbit through the beamline.
The projection of any other single trajectory specified by
the Initial Particle Parameters Window is also traced. The
Initial Particle Parameters Window is accessed from the
Button Bar at the top of the Bending Module Window.
The Bend Control panel located on the left side of the
central pane in the Bending Module Window is used to
adjust the bend and edge angles in any of the bending
magnets. Changes made with these controls will be
reflected in the beamline on the Model Space. Bend and
edge angles are modified with the Dial controls after
selecting a Bend Piece in the iconic representation of the
model displayed at the top of the window. The beamline
image in the central pane will be redrawn reflecting the
new angle.

As illustrated in Figure 31, the Bending Module Window
also supports a Zoom feature. To Zoom-In on a specific
area, use the mouse to drag a rectangle around the region
you wish to enlarge (holding down the mouse button while
dragging). When the mouse button is released, the image
will be redrawn, enlarged to the size of the central pane.
The Zoom-Out button restores the previous image.

The RayTrace button  shows the
magnetic mid-plane projection for
both the reference trajectory and
single particle ray.  The magnetic mid-
plane projection of the beam
envelope is drawn using the Envelope
button.

The Bend Controls, located on the left
side of the central pane, can be used
to adjust the reference trajectory
deflection angle for a selected Bend
Piece. It is recommended that you
save your work prior to making any
adjustments with the Dial Controls.
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Use the Mouse to Drag a Zoom Box 
Around the Region to be Enlarged

Dial Controls Dynamically 
Adjust Bend and Edge Angles 

for a Selected Bend Piece

Figure 31.  Zoom-In Feature of the Bending Module Window.

The Bending Module Window may be resized by dragging
the lower right corner of window.  The central pane of the
window will be constrained to a square in order to maintain
the proper perspective for the scaled image.
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Pieces Utilized in the
Focusing and Beding Modules

Beam
Drift
Quad

Solenoid
S-Bend
R-Bend
Bend
Edge

Thin Lens
Centroid
RF␣ Gap
Matrix
Rotate

Pieces Not Utilized in the
Focusing and Beding Modules

RMS Beam
Align
Kicker

Sextupole
Octupole

Plasma Lens
Accelerator

Septum

Pieces Not Impacting in the
Focusing and Beding Modules

Marker
Final

A subset of the all the availible PBO Lab optical elements
are supported in the Focusing and Bending Modules. The
list to the right summarizes which Pieces are, and are not,
supported by the trajectories tools. Models containing
those Pieces that are not supported can result in
unpredictable displays and should be removed from the
beamline on the Model Space prior to using the Focusing
and Bending Modules. In addition, not all supported Pieces
have been fully tested for numerical accuracy in the
trajectories tools for this release of PBO Lab, and so
caution is urged. Future releases of PBO Lab will
incorporate full support for additional PBO Lab Pieces
on the Palette Bar. Of course, certain Pieces, such as the
Marker and Final, do not impact the calculation of single
particle trajectories or envelopes.

This Section completes the discussion of using the PBO
Lab focusing and bending analysis tools. The analysis
tools do not use any of the Application Modules, and are
not required to set up or run any of the PBO Lab
Application Modules.  The following Section describes
the PBO Lab Plot Tool, which can be used to plot data
generated with the Focusing Module.
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Plot Tool
The Particle Beam Optics Laboratory supports a Plot Tool
which is accessed from the Tools Menu as illustrated in
Figure 32.  The Plot Tool is  not dependent on any of the
Application Modules available in PBO Lab.

Plot Tool Sub-Menu

Figure 32.  Plot Tool Sub-Menu.

The Plot Tool allows data generated from the Focusing
Module to be displayed in interactive Plot Windows.  The
Plot Windows provide a variety of features including
support for loading external data files for plotting.  Figure
33 illustrates the Plot Window for the Twiss Parameters
data that is generated with the Focusing Module.

The Plot Tool allows data generated
from the Focusing Module or from
external data files to be displayed in
interactive Plot Windows.  None of
the PBO Lab Application Modules are
required to use the PBO Lab Plot Tool.

Figure 33.  Plot Tool Window for Focusing Ray and Envelope Data.

The Plot Window shown in Figure 33 has been resized
horizontally and the plot scales have been set to run from
zero to the physical length of the beamline calculated by
the Focusing Module.
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Graph Plot Windows
Once a graph has been generated, the Graph Plot Window
may be left open and additional plot specifications can be
selected.  New Graph Windows will be opened with
subsequent runs so an unlimited number of Graph Plot
Windows may be created and left open for simultaneous
viewing.  The Graph Plot Windows may be resized from
thumb-nail size to full-screen.  Figure 34 shows some
example Graph Plot Windows for data generated with the
different Application Modules available in PBO Lab.

This Graph Plot shows the Horizontal Beam Centroid Position 
(XC), Horizontal Beam Centroid Angle (XPC), Vertical Beam 
Centroid Position (YC), Vertical Beam Centroid Angle (YPC) 

plotted as a function of Accumulated Beam Line Length

βx

This Graph Plot shows the Accelerator Functions         
(ALPHAY),          (BETAY),         (ALPHAX) and        

(BETAX) plotted as a function of the Accumulated 
Beam Line Length

βy α x

α y

This Graph Plot shows the Horizontal Beam Half 
Width (XBEAM), Horizontal Beam Half Angle 

(XPBEAM), Vertical Beam Half Width (YBEAM) 
and Vertical Beam Half Angle (YPBEAM) plotted as 

a function of Accumulated Beam Line Length

These two Graph Plot Windows are 
Examples of Final Phase Space Ellipse 

Plots (XP vs. X and YP vs. Y)

Figure 34.  PBO Lab Graph Plot Windows.
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Several interactive features are available to the user in the
PBO Lab Graph Plot Windows.  A Button Bar at the top
of the window provides options for printing the graph and
for copying the graph to the system clipboard.

Each plot variable is drawn in a different color, and is
identified in the Legend.  Clicking on a plot variable in
the Legend will hide or show that  data in the Graph Plot
Window. Above the Legend is a Pen Width pop-up with
selections that range from one to five.  The default is one
and for most graphs this is the preferred pen width.

Symbols for specific data points can be displayed by
pressing the Show Symbols button.  The  coordinates of
any plotted point can then be displayed by clicking on the
symbol for that point while holding the shift key down.

Graph scales are automatically calculated to fit the data
set.  However, using the Set Scale button, the vertical and
horizontal scales of the graph may be directly modified.
The Set Scale button activates the min and max plot scales
on the plot axes.  Simply type in the desired value and
press the Enter key.  You can also use the mouse to quickly
zoom in on a specific region of the graph.

Any region of a graph can be enlarged (Zoomed-In) by
making a drag box with the mouse.  Move the mouse to
the upper left corner of the region to be zoomed, and hold
down the left mouse button while dragging to the lower
right corner of the desired zoom region.  A drag box will
be displayed during this action.  When the mouse button
is released, the graph will be redrawn so that the region
enclosed by the drag box occupies the entire plotting area.
Figure 35 on the following page illustrates this feature.

The Button Bar at the top of Graph
Plot window provides controls for
printing and copying the graph.

The coordinates for any data point
can be shown by clicking on the
symbol for the desired point while
holding down the shift key.

Graph scales are automatically
calculated to fit the data set.
However, using the Set Scale button,
scales may be modified directly in the
Graph Plot Window.

Any region of the graph can be
enlarged (Zoomed In) by holding
down the mouse button while
making a drag box for the desired
zoom region.

66



PBO Lab 2.0 User Manual

Figure 35 illustrates a Zoom-In region that has been
created by using the mouse (with button held down) to
make a drag box around the desired zoom region.  The
window at the bottom of Figure 35 shows the zoomed
graph after releasing the mouse button.  An unlimited
number of zooms are available for any region of the graph,
providing an increasingly detailed display of the plot data,
by using multiple applications of the Zoom feature.  The
Zoom-Out button is used to return the graph to the previous
zoom level.

Use the Mouse to Make 
a Drag Box for the 

Desired Zoom Region

The Zoomed Graph 
After Releasing the 

Mouse Button

The Zoom Out Button 
can be used to Undo an 
Unlimited Number of 
Zoom In Operations

Figure 35.  Example illustrating drag box Zoom-In feature.
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Loading User Data into
Graph Plot Windows

PBO Lab Graph Plot Windows include support for loading
user specified plot data files.  This allows plot data to be
loaded directly into Graph Plot Windows that are created
for line plots as a function of beamline length.  This feature
can be used for a variety of purposes including loading
external data such as control system diagnostics into Graph
Plot Windows for comparison with simulation results from
the different PBO Lab Application Modules (e.g.
TRANSPORT, MARYLIE, etc.).  The Load User Data
option can also be used to accumulate the plot results from
multiple runs of an Application Module or to compare
results from different Application Modules in a single
Graph Plot Window.  Plot data generated with the PBO
Lab Focusing Module can also be combined with Graph
Plots produced with the different Application Modules.

The Load User Data feature is available in any Graph Plot
Window created from the Tools-Plot sub-menu, as well
as any Graph Plot Window generated from a
TRANSPORT Plot Specification for Matrix Elements vs.
Length, and  Envelopes, Centroids and Lattice Functions
vs. Length.  User plot data may also be added to Graph
Plot windows generated from MARYLIE Plot
Specifications for Lattice Functions, Lattice Properties,
Anharmonic Lattice Parameters and Envelopes as a
function of beamline length.

User specified plot data is incorporated into Graph Plot
Windows using the Load User Data button in the Button
Bar at the top of the Graph Plot Window.  A standard
open file dialog is then used to select a plot data file.  Any
of the Length plot data files generated by the different
PBO Lab Application Modules or by the PBO Lab
Focusing Module can be loaded directly.  External data
sources can created and loaded by using the standard
format described next.

User specified plot data can easily be
incorporated into PBO Lab Graph Plot
Windows for line plots as a function
of beamline length.

Refer to the Plot Specification Section
of the TRANSPORT Application
Module Supplement.

Refer to the Plot Specification Section
of the MARYLIE Application Module
Supplement.

Any of the Length plot data files
generated by the different PBO Lab
Application Modules or by the PBO
Lab Focusing Module can be loaded
directly into PBO Lab Graph Plots
Windows.
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The format for external (user supplied) plot data files is
identical to the format of the Length plot data files
generated by the various PBO Lab Application Modules
and the Twiss Parameter data file generated with the PBO
Lab Focusing Module.  The View menu provides
commands for opening and editing these plot files in a
text window.

The header at the top of the file must contain the keyword
“Length” as the first column heading, followed by any
number of user defined column headings for each column
of user specified plot data.  Each column of plot data will
be used to plot a line as a function of the lengths in the
first column.  Figure 36 illustrates an example of a user
supplied data file.

LENGTH    S12         S34
  0.30       145.0      -397.0
  0.31       120.0      -370.0
  0.32       149.0      -399.0
  0.33       160.0      -410.0
  0.47      -102.0       232.0
  0.48      -119.0       252.0
  0.49      -133.0       267.0
  0.50      -122.0       257.0
  0.66       122.0      -145.0
  0.67         96.0      -119.0
  0.68       125.0      -148.0
  0.69       136.0      -159.0
  0.85      -142.0       554.0
  0.86      -156.0       527.0
  0.87      -145.0       552.0
  0.88      -116.0       567.0

Figure 36.  User supplied plot data file.

A row of data represents a point along the cumulative
beamline length.  The length (taken from column one) is
used as the horizontal coordinate and the data from each
column in a row represents the vertical coordinate of the
points that will be plotted with a solid colored symbol in
the Graph Plot Window.  There is no limit on the number
of rows.  The number of columns (excluding the length
column) represents the number of lines that will be plotted.
There is no limit on the number of columns.  However,
the first column must be length data.

The Format of user plot data files is
identical to the line plot data files
generated by the various PBO Lab
Application Modules.

The first column of the Plot Data file
is for length data and must have the
“Length” heading.  Any number of
columns may follow with any user
specified column heading. Each of
these columns are used to plot lines
as a function of the lengths in the
first column.

There is no limit on the the number
of rows and columns in a User Data
file.
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By default the user data files loaded into a Graph Plot
Window are initially drawn with symbols only, as
illustrated in Figure 37.  Data points from each column
can be connected with lines by clicking on the legend
string for that data set in the Legend of the Graph Plot
Window.  Colors are assigned starting with red, then blue,
green and black, based on the column order in the plot
data file.  This sequence repeats for additional columns.

The Graph Plot window is automatically 
generated after running TRANSPORT 
with a User Defined Plot Specification 

for Matrix Elements vs. Length in 
Example B-Modified.pbol

Show and Hide the 
Symbols for User Loaded 
data independent from the 
original Graph Plot data

x = 0.32,
x = 0.32,

(S12)
(S34)

y =  149.0    
y = -399.0   

LENGTH    S12         S34
  0.30       145.0      -397.0
  0.31       120.0      -370.0
  0.32       149.0      -399.0
  0.33       160.0      -410.0
  0.47      -102.0       232.0
  0.48      -119.0       252.0
  0.49      -133.0       267.0
  0.50      -122.0       257.0
  0.66       122.0      -145.0
  0.67         96.0      -119.0
  0.68       125.0      -148.0
  0.69       136.0      -159.0
  0.85      -142.0       554.0
  0.86      -156.0       527.0
  0.87      -145.0       552.0
  0.88      -116.0       567.0

Shift-Click on a Symbol to 
Display its coordinates

Connect Symbols with lines by 
clicking on the string in the Legend

Figure 37.  Loading User Defined Plot Data in PBO Lab Graph Plot Windows.

The symbols for user loaded data points are always drawn
with solid squares.  These can be hidden with the Hide/
Show User Data Symbols button in the Button Bar of the
Graph Plot Window, independent of the original plot data
symbols.  There is no limit on the number of plot data
files that can be loaded into a Graph Plot Window.

Symbols can be connected with lines
by clicking on the legend string for
that data set in the Legend of the
Graph Plot Window.

Symbols for user loaded data are
always solid squares.  Use the Hide/
Show User Data Symbols button to
toggle the display for these symbols
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Figure 38 illustrates an example of the Load User Data
option using the “Example B-modified.pbol” model file
distributed with PBO Lab.  The Plot Specification has been
changed to show two of the fitting constraint variables
(S12 and S34 Sigma matrix elements) as a function of the
cumulative beamline length.  The Load User Data option
is used to compare the plot results  before and after fitting
in the same Graph Plot Window.  The Graph Plot Window
from the first TRANSPORT run (without fitting) is used
to Load the "TransportPlot" data file generated in the
second TRANSPORT run (with Fitting).

After Running TRANSPORT 
with Fitting

After Running TRANSPORT 
the first time without Fitting

The Graph Plot window from the first 
TRANSPORT run (without fitting) is used to 
Load the "TransportPlot" data file generated 
in the second TRANSPORT run (with Fitting)

Figure 38.  Accumulation of Plot Data for Multiple Runs (before and after Fitting).

The User Plot Data option can be
used to accumulate plot data for
comparison of multiple runs.

Refer to the Transport Plot Specification
Section of the TRANSPORT Application
Module Supplement.
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Plot data generated with the PBO Lab Focusing Module
can also be combined with beamline length plots produced
with the different Application Modules.  Figure 39
illustrates an example using “Example B-modified.pbol”
with the Plot Specification changed to show the AlphaX,
AlphaY, BetaX and BetaY Beam Twiss Parameters.  The
“TwissParameters” data file produced with the PBO Lab
Focusing Module is then loaded in to the Graph Plot
Window after running TRANSPORT.

 LENGTH    ALPHAX    ALPHAY    BETAX     BETAY   
0.00000   3.11399  -2.62021   0.75360  0.57890
0.17300   0.65834  -4.97074   0.10098  1.89214
0.26900  -1.63084   9.36867   0.17467  1.28986
0.30875  -2.46368   6.63293   0.33742  0.65379
0.34850  -3.29652   3.89721   0.56639  0.23522
0.44450   2.43303  -1.90052   0.68465  0.08393
0.48724   2.00106  -4.24902   0.49513  0.34676
0.52998   1.56909  -6.59751   0.34254  0.81034
0.62598  -1.58558   2.72163   0.34379  1.34114
0.67172  -2.05310   2.43490   0.51023  1.10528
0.71746  -2.52064   2.14817   0.71943  0.89565
0.81346   3.47456  -7.22131   0.58879  1.28003
0.86219   2.39264  -9.24461   0.30288  2.08242
0.91092   1.31071 -11.26784  0.12242  3.08198
0.95892   0.06436    3.17925  0.06070   3.50011

The "TransportPlot" data file is used to 
automatically generate the User Defined 

TRANSPORT Plot Specification following 
the execution of TRANSPORT.

The Specified TRANSPORT Plot is automatically 
generated for ALPHAX, ALPHAY, BETAX and 
BETAY as a function of the beamline length.
Each point is one step (element by element) 

along the cummulative length of the beamline.

        Length                AlphaX                  AlphaY                BetaX                   BetaY
0.000000e+000  3.114000e+000  -2.620200e+000  7.536000e-001  5.789000e-001
1.000000e-002  2.972055e+000  -2.756069e+000  6.927395e-001  6.326627e-001
2.000000e-002  2.830109e+000  -2.891938e+000  6.347178e-001  6.891428e-001
3.000000e-002  2.688164e+000  -3.027807e+000  5.795351e-001  7.483402e-001
4.000000e-002  2.546219e+000  -3.163675e+000  5.271912e-001  8.102550e-001
5.000000e-002  2.404274e+000  -3.299544e+000  4.776863e-001  8.748872e-001
6.000000e-002  2.262328e+000  -3.435413e+000  4.310203e-001  9.422368e-001
7.000000e-002  2.120383e+000  -3.571282e+000  3.871932e-001  1.012304e+000
8.000000e-002  1.978438e+000  -3.707151e+000  3.462050e-001  1.085088e+000
9.000000e-002  1.836493e+000  -3.843020e+000  3.080557e-001  1.160590e+000
1.000000e-001  1.694547e+000  -3.978889e+000  2.727453e-001  1.238809e+000
1.100000e-001  1.552602e+000  -4.114757e+000  2.402738e-001  1.319745e+000
1.200000e-001  1.410657e+000  -4.250626e+000  2.106412e-001  1.403399e+000
1.300000e-001  1.268711e+000  -4.386495e+000  1.838475e-001  1.489770e+000
…

9.209200e-001  9.984910e-001  -8.665198e+000  9.939680e-002  3.281914e+000
9.309200e-001  7.230047e-001  -5.745665e+000  8.223428e-002  3.426465e+000
9.409200e-001  4.741225e-001  -2.615999e+000  7.029947e-002  3.510338e+000
9.509200e-001  2.426863e-001   6.093390e-001  6.315322e-002  3.530466e+000
9.589200e-001  6.436229e-002   3.179234e+000  6.070162e-002  3.500098e+000

The "TwissParameters" Data File is generated 
from the PBO Lab Focusing Tool:

The solid square symbols show 
the User Data loaded from the 

TwissParameters data file.

 A step size of 0.01 meters (103 steps) was used 
to gather more data points along the length of 
the beamline in the TwissParameters data file.

Figure 39.  PBO Lab focusing data loaded into a Graph Plot Window.

Refer to the Focusing Modules
Section in this Chapter.

72



PBO Lab 2.0 User Manual

Data Interchange Tool
The Particle Beam Optics Laboratory supports an ASCII
file-based data interchange for beamline element
parameters.  Element parameters for Pieces in the
beamline may be selected as Import Variables in the
Special Parameter Settings Windows.  These parameters
can then be loaded from an external data file or written to
a data file from PBO Lab.  Selected parameters are
imported into PBO Lab or exported from PBO Lab using
the commands in the Data Interchange sub-menu of the
Tools menu.

Figure 40.  Data Interchange Sub-Menu.

There are three commands in the Data Interchange sub-
menu, as illustrated in Figure 40: Import ASCII File,
Export ASCII File and Export ASCII and View.  The first
command is used to import parameters into the PBO Lab
beamline model from an external text file.  The second
command is used to Export selected parameters to a text
file.  The third command is equivalent to the Export ASCII
File command, in that it generates an export file for
selected parameters, but it also opens the file in a Text
Editor Window.

Import parameters are selected in Special Parameter Settings
Windows (S-Windows).  Figure 41 illustrates selecting a
Quadrupole Magnetic Field Gradient parameter as an
interchange variable in the TRANSPORT tab panel of the
S-Window.  S-Windows have application-specific tab panels
for installed Application Modules that are described in the
individual Application Module Supplements.  A parameter
that has been selected as an Import Parameter can not be
defined as a Fitting Variable or Algebraic Expression for
TRANSPORT.  Similar constraints are imposed for
selecting interchange variables in other application-specific
tab panels in Parameter S-Windows.

Element parameters for Pieces in the
beamline model may be loaded from
an external data file using the Data
Interchange Tool.

The Data Interchange sub-menu is
accessed from the Tool menu in the
Document Window.

Import parameters are selected in
Special Parameter Settings Windows
(S-Windows) accessed with
parameter S-Buttons in the Piece
Windows.
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Parameter "S" buttons open Special 
Parameter Settings Windows for 

Application Specific Parameter Options
or for Selecting a Parameter as an 

Import/Export Variable

Figure 41.  Selecting a Parameter as an Interchange Variable.

Import Parameters are application-specific and therefore
PBO Lab requires an Application Module to be installed
in order to select Import Parameters in the beamline.
Figure 42 shows an S-Window with no Application
Modules installed.

PBO Lab requires an Application
Module to be installed in order to
select Import Parameters in the
Special Parameter Settings Windows.
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Figure 42.  Special Parameter Settings Window with no
Application Modules installed.
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Once Import Variables have been selected in the beamline
model, the Export ASCII and View command can be used
to create an external data file containing those parameters.
The data file will be automatically opened in a Text Editor
Window as illustrated in Figure 43.

It may be convenient to use the
Export ASCII and View command to
generate an export data file and then
use that file as a templet for your
import data file.

Import Parameters are matched by
name so their order is not important.
However, entries that do not have
corresponding Variable Names in the
beamline model will be ignored.

Use the File Menu in the Text Editor Window 
to Save any changes or Rename the Data File

The Header for the Data File is 
the First Line of the File

Sub-Headers will be Included for each 
of the Installed Application Modules

The Import Variable Name, Value and 
Units are listed Separatly Under each 

Application Module Sub-Header

Figure 43.  Generating an External Data File for Import Parameters.

The syntax for importing external data is identical to the
export file syntax shown in Figure 43.  It may be
convenient to use the Export ASCII and View command
to generate an export data file and then use that file as a
templet for your import data file.  This insures that the
data file will correspond with the selected Import Variables
in the beamline model.  Each entry in the Import file must
have a Variable Name that matches the names assigned to
the Import Parameter selections in the beamline model.
The Variable Name is followed by the numerical Parameter
Value in the units shown in the Export file templet.
However the quoted units strings are not required in an
Import file.  Import Parameters are matched by name in
PBO Lab so that the order they appear in the Import file
is not important.  Entries in the Import file that do not
have corresponding Variable Names in the beamline model
will be ignored.  The File Menu in the text editor window
can be used to save any changes or to rename the file.
The Edit Menu supports the standard cut, copy and paste
commands.  The Font Menu can be used to change the
font in the Text Editor Window.
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Import Variable List Window
PBO Lab provides a List Window that organizes all of
the user specified Import Variables for the entire beamline
model.  The Import Variable List Window is accessed from
the Data Interchange sub-menu in the Tools Menu as
illustrated in Figure 44.  The List Window shows the Piece
Label, Parameter Name, Parameter Variable Name,
Parameter Value and Units for each Import Variable
selected in the beamline model.  Double clicking an entry
in the List Window will open the associated Piece Window
containing that Import Variable.

Double Click an Entry to Open 
the Associated Piece Window

Figure 44.  All Import Variables can be accessed from a List Window.

Double clicking an entry in the Import
Variable List Window will open the
associated Piece Window for that
Parameter.
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PBO Lab User Preferences
The Particle Beam Optics Laboratory has a Preferences
Window which is accessed from the PBO Lab Preferences
menu command in the Tools Menu of the Document
Window.

Figure 45.  PBO Lab Preferences Menu Command.

There are three tab panels in the PBO Lab Preferences
Window as illustrated in Figure 46.  The Main tab panel
contains general PBO Lab preferences.  The Simulations
tab panel has Application Module preferences and the
Focusing & Bending tab panel contains preferences for
the PBO Lab Focusing and Bending Modules.

Figure 46.  PBO Lab Preferences Window.

PBO Lab Preferences are accessed
from the Tools Menu of the
Document Window.
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The Main tab panel of the PBO Lab Preferences Window
has selections for Application Type and Text Window Font.
The Application Type preference is a special feature for
PBO Lab that supports the definition of beamline models
that can reference elements (using Alias Pieces) between
multiple Document Windows.  The default for
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the Application Type preference is Single Model (Single
Document Mode), which is the normal configuration for
the PBO Lab user interface.  The Multiple Model
Application Type (Multiple Document Mode) modifies
the user interface so that a persistent link can be maintained
between multiple Document Windows.  The user interface
for Document Windows is the same in both configurations.
However, there is a special Problem Setup user interface,
shown in Figure 47, that is used in the Multiple Document
Mode.

The Multiple Document Mode allows multiple 
Beamline Model Documents to be Encapsulated 

in a Single PBO Lab Beamline Problem 

Figure 47.  Multiple Document Mode
Problem Setup Window .

With the Multiple Document Mode configuration,
multiple Documents are created and linked together in
the Problem Setup Window.  The most significant feature
of the Multiple Document Mode is that beamline elements
can be Aliased between Document Windows in the same
beamline problem.  The Multiple Document Mode and
Problem Setup Window are only required in special cases
where beamline elements need to be Aliased between
Document Windows.  Using the Problem Setup Window
is described in a special Supplement to the PBO Lab User
Manual that is available by request from AccelSoft.

The standard PBO Lab configuration (Single Document
Mode) does not permit Aliases of beamline elements to
be created between Documents.  An Alert, such as that
shown in Figure 48, results when trying to Copy an Alias
Piece to another Document Window.

Refer to the Section on Aliases in the
PBO␣ Lab Interface Chapter.

Multiple Document Mode allows
beamline elements to be Aliased
between Document Windows in the
same beamline problem.

The Multiple Document Mode and
Problem Setup Window are only
required in special cases where
beamline elements need to be
Aliased between Document
Windows.
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The Text Window Font Preference is
used to change the font in PBO Lab
Text Editor Windows.
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Figure 48.  Cannot Copy Alias Alert.

In addition to the Application Type Preference, the Main
tab panel of the PBO Lab Preferences Window also has a
user preference for changing the font that will be used in
PBO Lab text editor windows.  The Choose Font button
opens a standard font selection window as illustrated in
Figure 49.  The font selection and size is applied to all of
the PBO Lab text windows, including those opened
automatically for displaying computational results of
Application Modules and Text Windows opened using the
various View Menu commands in the Document Window.

Figure 49.  Selecting the Font for Text Editor Windows.
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The Simulations tab panel is used for
application-specific user preferences.

PBO Lab can generate native input
for both TRANSPORT versions 1.0
and 1.5.

The Focusing & Bending tab panel
has user preferences for the PBO Lab
Focusing Module and the Bending
Module.
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The Simulations tab panel in the PBO Lab Preferences
Window, shown in Figure 50, is for application-specific
user preferences.  There is a Transport preference that has
been included here for generating the native TRANSPORT
input for either version 1.0 or for the new version 1.5
TRANSPORT application.  Previous versions of PBO Lab
have used the 1.0 version of TRANSPORT, which has
since been replaced with the 1.5 version of the application.
This user preference is included for those users who wish
to continue using the older version of the
TRANSPORT application that was shipped with previous
versions of PBO Lab.  The default for this preference is
for the newer TRANSPORT 1.5 version, which is
currently being distributed as part of the
TRANSPORT Application Module for PBO Lab.

Figure 50.  Simulations Tab Panel for
PBO Lab User Preferences.

The Focusing & Bending tab panel of the Preferences
Window has user preferences for the PBO Lab Focusing
Module and the Bending Trajectories Module. The Initial
Beam preferences are used in both the Focusing and Bending
Modules for the Envelope calculations.  The Diagnostic
preferences are used in the Focusing Module to generate
data files from the Ray Trace and Envelope calculations.
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Figure 51.  Initial Beam Parameters for the Focusing and Bending Modules.

Refer to the Sections on the PBO Lab
Focusing and Bending Modules in
this Chapter.
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Figure 51 illustrates the Focusing & Bending tab panel of
the Preferences Window.  There are three Initial Beam
Preferences for use with the Focusing and the Bending
Modules.  The three selections refer to the Beam Piece
parameters that will be used for Envelope calculations.
The first selection is the default and is used to specify an
initial beam with the Courant-Snyder (Twiss) parameters
of the Initial Beam Piece in the beamline model of the
Document Window.  The second selection specifies an
initial beam with the Semi-Axes parameters from the
Initial Beam Piece.
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The third selection will use the current setting for the Beam
Parameters pop-up in the Initial Beam Piece, either Twiss
or Semi-Axes parameters.  Figure 51 illustrates the
relationship between the Initial Beam Piece and the Initial
Beam preferences for the Focusing & Bending Modules.
Note that the Initial Beam Piece contains two independent
sets of beam parameters, one for the Twiss representation
and another for Semi-Axes.  If either of the first two
selections in the Initial Beam Preferences are used then
the selected parameters will be used independent of the
Beam Parameters selection in the Beam Piece Window.
If the last preference is selected, then the Focusing and
Bending Modules will use the parameters corresponding
to the Beam Parameters selection in the Beam Piece
Window.

The Diagnostic Files Preferences are used in the Focusing
Module.  There are two check boxes that correspond to
numerical data files which can be generated for the Ray
Trace and the Envelope plots in the Focusing Module
Window.  The ray and envelope data and the phase space
ellipse data can be written to data files by selecting these
preferences.  If these preferences are not selected then
the data is calculated for the plots in the Focusing Module
Window but it is not written to the individual data files.
Turning these preferences off will speed up the processing
time for large models and for calculations with a very
small Maximum Step Size Global Parameter setting.
These data files are overwritten each time the Ray Trace
or Envelope calculations are made.  The format of these
files is compatable for loading into a PBO Lab Graph
Plot Window.  There are specific commands in the Tools
menu (Figure 52) for opening Plot Windows for both the
Focusing Rays & Envelopes data file and the Focusing
Twiss Parameters data file when these user preferences
have been selected.

Plot Tool Sub-Menu

Figure 52.  Plot Tool Sub-Menu.

Commands in the Tools menu can be
used to open Plot Windows for both
the Focusing Rays & Envelopes data
file and the Focusing Twiss
Parameters data file. Refer to the
previous Section in this Chapter on
the PBO Lab Plot Tool.
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This Section completes the discussion of the PBO Lab
Analysis Tools and User Preferences. The Analysis Tools
do not require installation of any PBO Lab
Application Module, and Analysis Tools are not required
in order to set up beamline models or run any of the
Application Modules.
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This Section describes the interactive tutorials and help
features that are integrated with the PBO Lab application.
The tutorials are aimed at assisting first-time users in
understanding the beam optics models upon which
TRANSPORT relies, as well as for learning about the
technology of accelerators and various beam physics
phenomena. These educational features were developed
in part under a Small Business Innovation Research
(SBIR) grant (No. DE-FG03-94ER81767) from the U. S.
Department of Energy to supplement the Shell for Particle
Accelerator Related Codes (S.P.A.R.C.). The tutorials do
not use TRANSPORT, nor do they result in any additional
data written to the Transport Input files.

Tutorial Modules
An extensive interactive tutorial system has been
integrated with the PBO Lab user interface. This Section
summarizes how the interactive tutorial system is used.

The PBO Lab Tutorials are composed of a series of
Tutorial Modules, each of which contains two primary
components: an interactive Pictorial and a hypertext
Tutorial. The two components work together for each
Tutorial Module, and each module can be navigated
independently. A Tutorial Module is opened by selecting
the Tutorial button that appears in the upper right corner
of Piece Windows and other PBO Lab windows. This
opens the interactive Pictorial Window, which is navigated
using the PREV and NEXT buttons in the lower left panel
of the window. The hypertext Tutorial is opened using
the Go button in the bottom right panel of the Pictorial
Windows. The hypertext Tutorials for all of the Tutorial
Modules can also be opened using the Hypertext Help
command in the Help menu of the PBO Lab Document
Window.

The hypertext pages of each Tutorial Module provide links
to many parts of the PBO Lab tutorial system. Hyperlinks
are generally of two types. Pop-up topics provide brief
information on the hyperlink selection, and the pop-up
window used to display the material disappears on the
next mouse or keyboard action by the user.

PBO Lab Pieces Supported with
Tutorial and Pictorial Modules:

Beam
Drift
Quad
Sextupole
Bend
S-Bend
R-Bend
Edge
RMS Beam
Centroid
Solenoid
Thin Lens
Rotate

PBO Lab 2.0 User Manual
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Entries in the PBO Lab Glossary are examples of the use
of pop-up topics. Discussion topics present more detailed
information on the hyperlink selection, and will usually
contain further hyperlinks to additional information in the
PBO Lab Tutorial system. Discussion topics follow an
outline format in which the user has several options for
navigating through the discussion topic pages. In addition,
there are Pictorial pages that are associated with specific
Tutorial buttons in the PBO Lab windows. The Pictorial
topics are navigated as though advancing or retreating
through a slide show presentation.

Tutorial Equation pages provide the
user with a set of specialized scientific
calculators that contain built-in
functions related to the physics and
technology of charged particle optics.

Figure 53.  Quadrupole Interactive Tutorial Equation Page.

Pictorial Pages
Selecting the Tutorial button that appears in the upper right
corner of a PBO Lab Piece Window activates the interactive
Pictorial associated with that beamline element. The
Pictorial pages present results pertinent to the optics
modeling or calculations for the user inputs of that particular
PBO Lab window. The pages displayed in the Pictorial
Window are navigated using the buttons labeled PREV and
NEXT, located in the lower left panel of the Window.
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The content of Pictorial pages is adjusted interactively
based upon the current values of the user input parameters
in the window. For example Figure 53 shows an equation
page in a Quadrupole Pictorial that gives the R-matrices
and illustrates the first order effects on the two transverse
phase planes. When the user changes the quadrupole
strength or any other parameter, the page is automatically
updated to reflect the new parameters.

Magnetic Quadrupoles

Previous and Next Buttons step through 
Graphic and Equation Tutorial Pages 

Use GO Buttons to Bring up 
HyperText Help Windows

Use the Tutorial button in Piece 
Windows to access Interactive 
Physics Tutorials for that Piece

Figure 54.  Using the PBO Lab Interactive Tutorials.

Graphic elements and text, as well as numerical data, are
updated. Each page is tied to a particular PBO Lab window
so that the Pictorials for different windows, including those
for the same type of beamline element (e.g. two different
quadrupoles), will display a distinct set of pages associated
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with the parameter settings of that element. Consequently,
the Piece Window and its Pictorial Equation pages can be
used together as a specialized calculator with built-in optics
and technology functions. Figure 54 shows additional Tutorial
Pages for a Quadrupole beamline element.

Hypertext Tutorials
A more detailed treatment of material is presented in the
hypertext component of PBO Lab Tutorial Modules, which
is activated using the Go button located on the lower right
panel of each Tutorial Window. Figure 55 illustrates a
hypertext Tutorial Window for a Quadrupole element.

Hypertext Links Indicated 
with Dashed Underlines will 

Open Pop-up Topics

Hypertext  Links Indicated 
with Solid Underlines 

Navagate Discussion Topics

Figure 55.  Hypertext Tutorial Window for Quadrupole.

You may navigate forward or
backward through your selected
tutorial pages using the
corresponding buttons located in the
bottom panel of the tutorial
windows.
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The hypertext component of each Tutorial Module
provides links to many parts of the PBO Lab tutorial
system. Hyperlinks are generally of two types: discussion
topics and pop-up topics. Hypertext links for discussion
topics are indicated by solid underlines and are used to
navigate a series of pages that frequently contain hypertext
links to other information, including links to other pages
in the series and links to other discussion topics in the
PBO Lab Tutorials. Hypertext links for pop-up topics are
indicated by dashed underlines. Pop-up topics provide
brief information on the selected hypertext topic. The pop-
up window used to display the material disappears on a
subsequent mouse click or keyboard action (Figure 55).

Discussion topics present more detailed information on
the selected hyperlink topic, and may contain further
hyperlinks to additional information in the PBO Lab
Tutorial. Discussion topics follow an outline format and
the user has several options for navigating the pages.

Navigate Tutorials with a Variety of 
Controls: Hyperlink, Next Topic, 

Previous Topic, Back, Forward, Topic 
Search, Keyword Search, Go To Topic, 
Go To Keyword, and Go To Bookmark

Figure 56.  Navigating PBO Lab Hypertext Tutorials.

The commands in the Navigate menu and the buttons at
the bottom of the hypertext Tutorial Window can be used
to navigate through the Tutorial Pages (Figure 56). The Next
Topic button (marked with the symbol >>), follows the
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outline format of the discussion topic. The Previous Topic
button (marked with the symbol <<) is used to browse
backwards through a discussion topic. The Back button is
used to navigate backward through previously selected
links. The Forward button can then be used to page forward
again through visited links. The Search button opens the
Topic Search Dialog, which is used to search the tutorial
database by Topic or by Keyword. The GoTo button opens
the Topic GoTo Dialog. The Mark button is used to place a
bookmark for the current page, which can then be used in a
Search or GoTo command.

All main discussion topics conclude with a pop-up topic
that provides a summary of the material covered in that
particular topic. A summary of the material covered in
any main discussion topic may also be viewed using the
“GO! ->” pop-up topic hyperlink as illustrated in Figure
57, which shows the Magnetic Quadrupole summary.

Figure 57.  Hypertext Tutorial Pop-up Topic of
Magnetic Quadrupole Summary.

Hypertext links indicated by broken
underlines bring up pop-up windows
such as additional Glossary
definitions.

In contrast, links that have solid
underlines navigate Discussion topics,
which are typically a series of pages
on a particular subject in the PBO Lab
Tutorial.
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Browse Tutorial Discussion Topics 
Using a Variety of Navigation 

Controls and Hyperlinks

Click on Dashed Hyperlinks to Show 
Pop-up Topic Windows Related to 

Selected Subject 

Use GO Button on Pictorial Pages (Figure 54) 
to Bring Up HyperText Tutorial Windows or  
to Select Topics from the PBO Lab Tutorial 

Outline (Figure 61)

Both physics and technology are 
addressed in Tutorial pages 

Figure 58.  Hypertext Tutorial Windows for a Quadrupole Element.
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Particle Beam Optics Glossary
The Particle Beam Optics Glossary contains definitions
and brief discussions of many of the concepts and terms
used in particle optics and in accelerator physics and
engineering. Individual entries in the PBO Lab Glossary
appear as Pop-up Topics when selected using hypertext
links from other parts of the PBO Lab Tutorial. The
Glossary may also be browsed using the GoTo button or
menu command in any Hypertext Tutorial window and
then using the Glossary option as shown in Figure 59
below.

Figure 59.  Topic GoTo Dialog.

Selecting the Glossary button in the Topic GoTo Window
activates a hypertext Tutorial Window for the Particle
Beam Optics Glossary as illustrated in Figure 60. Use the
Next Topic button (marked with the symbol >>) to browse
through the Glossary. The Previous Topic button (marked
with the symbol <<) is used to browse backwards through
the Glossary. Clicking on hypertext links may be used to
access additional Glossary definitions and further explore
selected subjects in other parts of the PBO Lab Tutorial.

Use the Topic GoTo Dialog to access
user defined bookmarks, the PBO
Glossary or the tutorial outline pages.
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Move through Glossary Pages 
using the Previous and Next 

Topic Buttons

Glossary Pages

Figure 60.  PBO Lab Particle Beam Optics Glossary.
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PBO Lab Tutorial Outline
A hypertext outline for all the PBO Lab Tutorial discussion
topics can be opened using the Hypertext Tutorial Menu
command in the Document Window. The outline can also
be accessed from the Contents button in the Topic GoTo
Dialog as shown in Figure 61 below. Any topic may be
selected from the outline and accessed using the discussion
topic hyperlinks.

Use the Contents Button to Activate 
the PBO Lab Tutorial Outline 
(Hyperlink Table of Contents)

Figure 61.  PBO Lab Tutorial Hypertext Outline.

Use the Hypertext Help command in
Tutorial Menu to open a hypertext
outline for all the PBO Lab Tutorial
discussion topics.
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Using Tutorial Bookmarks
The Topic GoTo Dialog can also be used to access any
user-defined bookmarks. Bring up the Topic GoTo Dialog
(Figure 62) from the GoTo button at the bottom of a
Tutorial Window or from the GoTo item in the Navigate
Menu. Select a pre-defined bookmark in the list of
bookmarks and go to that page using the GoTo Mark
button.

Select a Bookmark 
and Press the 

Go To Mark Button

Figure 62.  GoTo a User Defined Bookmark.

Bookmarks are defined for a Tutorial Page using the Mark
button at the bottom of a Tutorial Window, or by using
the Bookmark command in the Navigation Menu of a
Tutorial Window. A previously defined bookmark may
also be removed. If a Tutorial Page is already marked,
then using the Unmark button or menu command will
remove the page from the bookmark list.
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Use File Menu commands to print
tutorial pages.

Use Edit Menu commands to copy
tutorial pages.

Searching Tutorial Pages
The Search command in the Navigate Menu of Tutorial
Windows, or the Search button at the bottom of the Tutorial
Windows, is used to bring up the Topic Search Dialog
shown in Figure 63. PBO Lab Tutorials can be searched
by discussion topics and by keywords. After selecting an
item from the list of topics or keywords, use the GoTo
Selection button to bring up the selected Tutorial Page.

Figure 63.  Topic Search Dialog.

Printing and Copying Tutorial Pages
The content of the PBO Lab Tutorial Pages may be printed
using the Print command in the File Menu of the Tutorial
Window. Alternatively, the Copy and Copy Part of Topic
commands in the Edit Menu may be used to copy the
content of the PBO Lab Tutorial Pages to the system
clipboard. The content can then be pasted into a text or
graphics program of your choice.
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This Section completes the discussion of using the PBO
Lab Tutorial system. The tutorials do not require any of
the PBO Lab Application Modules to be installed, and
they are not required in order to set up beamline models
or run any of the Application Modules.
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